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Ansoft Maxwell Fundamentals

What is Maxwell?
Maxwell is a high-performance interactive software package that uses finite 

element analysis (FEA) to solve three-dimensional (3D) electric, magnetostatic, 

eddy current, and transient problems. 

Electric 3D fields:Electric 3D fields:Electric 3D fields:Electric 3D fields:

Electrostatic 3D fields in dielectrics caused by a user-specified distribution 

of voltages and charges. Additional computed quantities you can specify 

include torque, force, and capacitances.

Electric 3D fields in conductors, characterized by a spatial distribution of 
voltage, electric field, and DC current density. The main additional quantity 

in this case is power loss.

A combination of the first two with conduction solutions being used as 

boundary conditions for an electrostatic problem.

MagnetostaticMagnetostaticMagnetostaticMagnetostatic::::

Linear and nonlinear 3D magnetostatic fields caused by a user-specified 

distribution of DC current density, voltage, permanent magnets, or 

externally applied magnetic fields. Additional computed quantities you can 

specify include torque, force, and inductances (self and mutual).

Eddy current: Eddy current: Eddy current: Eddy current: 

Harmonic (sinusoidal variation in time) steady state 3D magnetic fields with 

pulsation-induced eddy currents in massive (solid) conductors caused by 

one of the following: by a user-specified distribution of AC currents (all with 
the same frequency but with possibly different initial phase angles), or by 

externally applied magnetic fields. The eddy solution is a full wave solution 

that includes electromagnetic wave radiation effects.

Transient:Transient:Transient:Transient:

Time domain 3D magnetic fields caused by permanent magnets and 
windings supplied by voltage and/or current sources with arbitrary variation 

as functions of time; electrical circuits will be connected with the windings. 

Rotational or translational motion effects can also be included in the 

simulation.
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Installing the Ansoft Maxwell Software

System Requirements (Windows)
Supported Platforms:Supported Platforms:Supported Platforms:Supported Platforms:

Windows 2000 Professional

Windows XP Professional

Windows XP Professional x64 Edition

Windows Server 2003

32323232----Bit System RequirementsBit System RequirementsBit System RequirementsBit System Requirements

Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:

Processor: All fully compatible 686 (or later) instruction set 
processors, 500 MHz

Hard Drive Space (for Maxwell software): 200 MB

RAM: 512 MB

Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):

Processor: All fully compatible 786 (or later) instruction set 
processors, 1 GHz

Hard Drive Space (for Maxwell software and temporary files): 500 MB

RAM: 2 GB

64646464----bit System Requirementsbit System Requirementsbit System Requirementsbit System Requirements

Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:

Supported processors: AMD Athlon 64, AMD Opteron, Intel Xeon with 
Intel EM64T support, Intel Pentium 4 with Intel EM64T support

Hard Drive Space (for Maxwell software): 200 MB

RAM: 2 MB

Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):

Supported processors: AMD Athlon 64, AMD Opteron, Intel Xeon with 
Intel EM64T support, Intel Pentium 4 with Intel EM64T support Video 
card: 128-bit SVGA or PCI Express video card 

Hard Drive Space (for Maxwell software and temporary files): 700 MB

RAM: 8 GBPentium –based computer

512 MB RAM minimum

8MB Video Card minimum

Mouse or other pointing device

CD-ROM drive
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Installing the Ansoft Maxwell Software

System Requirements (Sun Solaris)

Supported Platforms:Supported Platforms:Supported Platforms:Supported Platforms:

Solaris 8

Solaris 9

Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:

Processor: UltraSparc v9 processor, 450 MHz

Hard Drive Space (for Maxwell software): 550 MB

RAM: 1 GB

Recommended Minimum Configuration:Recommended Minimum Configuration:Recommended Minimum Configuration:Recommended Minimum Configuration:

Processor: UltraSparc v9 dual processor or better, 900 MHz

Hard Drive Space (for Maxwell software and temporary files): 800 MB

RAM: 4 GB

Note: Note: Note: Note: You must install Sun OpenGL libraries before installing and running 

Maxwell. This is available for free download at the following location: 

http://wwws.sun.com/software/graphics/opengl/download.html

Note: Note: Note: Note: Some older graphics cards may have minor display issues (such as check 

marks or a “t” appearing in a report title).
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Installing the Ansoft Maxwell Software

System Requirements (Red Hat Enterprise Linux v3)

32323232----Bit System RequirementsBit System RequirementsBit System RequirementsBit System Requirements

Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:

Processor: All fully compatible 686 (or later) instruction set 
processors, 500 MHz

Hard Drive Space (for Maxwell software): 200 MB

RAM: 512 MB

Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):

Processor: All fully compatible 786 (or later) instruction set 

processors, 2GHz

Hard Drive Space (for Maxwell software and temporary files): 700 MB

RAM: 2 GB

64646464----bit System Requirementsbit System Requirementsbit System Requirementsbit System Requirements

Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:Minimum System Requirements:

Supported processors: AMD Athlon 64, AMD Opteron, Intel Xeon with 

Intel EM64T support, Intel Pentium 4 with Intel EM64T support

Hard Drive Space (for Maxwell software): 200 MB

RAM: 2 MB

Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):Recommended Minimum Configuration (for Optimal Performance):

Supported processors: AMD Athlon 64, AMD Opteron, Intel Xeon with 

Intel EM64T support, Intel Pentium 4 with Intel EM64T support Video 
card: 128-bit SVGA or PCI Express video card 

Hard Drive Space (for Maxwell software and temporary files): 700 MB

RAM: 8 GB
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Installing the Ansoft Maxwell Software

Installing the Ansoft Maxwell Software
For up-to-date information, refer to the Maxwell Installation Guide

Starting Ansoft Maxwell
1. Click the Microsoft StartStartStartStart button, select ProgramsProgramsProgramsPrograms, and select the Ansoft, Maxwell Ansoft, Maxwell Ansoft, Maxwell Ansoft, Maxwell 

11 11 11 11 program group.  Click Maxwell 11Maxwell 11Maxwell 11Maxwell 11.

2.2.2.2. Or Or Or Or Double click on the Maxwell 11 icon  on the Windows Desktop
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Converting Older Files

Converting Older Maxwell file to Maxwell v11

Because of changes to the Maxwell files with the development of Maxwell v11, 

opening a Maxwell document from an earlier release may take more time than 

you are used to experiencing.  However, once the file has been opened and 

saved, subsequent opening time will return to normal

Ansoft Maxwell v11 provides a way for you to automatically convert your Maxwell 
projects from an earlier version to the Maxwell v11 format.  

To access Maxwell projects in an earlier version.

From Maxwell v11From Maxwell v11From Maxwell v11From Maxwell v11, 

1. Select the menu item File > OpenFile > OpenFile > OpenFile > Open

2. Open dialog

1. Files of Type:  Ansoft Legacy EM Projects (.Ansoft Legacy EM Projects (.Ansoft Legacy EM Projects (.Ansoft Legacy EM Projects (.clsclsclscls))))

2. Browse to the existing project and select the .cls file

3. Click the OpenOpenOpenOpen button

NOTENOTENOTENOTE:  You should make backup copies of all Maxwell projects created with 

a previous version of the software before opening them in Maxwell v11.
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Getting Help

Getting Help
If you have any questions while you are using Ansoft Maxwell you can find 

answers in several ways:

Ansoft Maxwell Online HelpAnsoft Maxwell Online HelpAnsoft Maxwell Online HelpAnsoft Maxwell Online Help provides assistance while you are working.

To get help about a specific, active dialog box, click the HelpHelpHelpHelp button 
in the dialog box or press the F1F1F1F1 key.

Select the menu item Help > ContentsHelp > ContentsHelp > ContentsHelp > Contents to access the online help 

system.

TooltipTooltipTooltipTooltips are available to provide information about tools on the 

toolbars or dialog boxes.  When you hold the pointer over a tool for a 
brief time, a tooltip appears to display the name of the tool.

As you move the pointer over a tool or click a menu item, the Status Status Status Status 

BarBarBarBar at the bottom of the Ansoft Maxwell window provides a brief 

description of the function of the tool or menu item.

The Ansoft Maxwell Getting Started guide provides detailed 

information about using Maxwell to create and solve 3D EM projects.

Ansoft Technical SupportAnsoft Technical SupportAnsoft Technical SupportAnsoft Technical Support

To contact Ansoft technical support staff in your geographical area, 

please log on to the Ansoft corporate website, www.ansoft.com and 
select ContactContactContactContact. 

Your Ansoft sales engineer may also be contacted in order to 

obtain this information.

Visiting the Ansoft Web Site
If your computer is connected to the Internet, you can visit the Ansoft Web site to 

learn more about the Ansoft company and products. 

From the Ansoft Desktop

Select the menu item Help > Ansoft Corporate WebsiteHelp > Ansoft Corporate WebsiteHelp > Ansoft Corporate WebsiteHelp > Ansoft Corporate Website to access 

the Online Technical Support (OTS) system.

From your Internet browser

Visit www.ansoft.com
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Getting Help

For Technical Support
The following link will direct you to the Ansoft Support Page.  The Ansoft Support 

Pages provide additional documentation, training, and application notes. 

Web Site: http://www.ansoft.com/support.cfm

Technical Support: 

9-4 EST: 

Pittsburgh, PAPittsburgh, PAPittsburgh, PAPittsburgh, PA

(412) 261-3200 x0 – Ask for Technical Support

Burlington, MABurlington, MABurlington, MABurlington, MA

(781) 229-8900 x0 – Ask for Technical Support 

9-4 PST: 

San Jose, CA San Jose, CA San Jose, CA San Jose, CA 

(408) 261-9095 x0 – Ask for Technical Support

Portland, ORPortland, ORPortland, ORPortland, OR

(503) 906-7944 or (503) 906-7947 

El Segundo, CAEl Segundo, CAEl Segundo, CAEl Segundo, CA

(310) 426-2287 – Ask for Technical Support
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WebUpdate

WebUpdate
This new feature allows you to update any existing Ansoft software from the 

WebUpdate window. This feature automatically scans your system to find any 

Ansoft software, and then allows you to download any updates if they are 

available. 



Ansoft Maxwell 3D Field Simulator v11 User’s Guide 12

Ansoft Terms

Ansoft Terms
The Ansoft Maxwell window has several optional panels:

A Project ManagerProject ManagerProject ManagerProject Manager which contains a design tree which lists the structure of 

the project.  

A Message ManagerMessage ManagerMessage ManagerMessage Manager that allows you to view any errors or warnings that 
occur before you begin a simulation.

A Property WindowProperty WindowProperty WindowProperty Window that displays and allows you to change model 

parameters or attributes. 

A Progress WindowProgress WindowProgress WindowProgress Window that displays solution progress.

A 3D Modeler Window3D Modeler Window3D Modeler Window3D Modeler Window which contains the model and model tree for the 
active design.  For more information about the3D Modeler Window, see 

chapter 1.

Menu 

bar

Progress 

Window

Property Window

Message 

Manager

Project

Manager

with project

tree

Status 

bar

3D Modeler

Window

Toolbars

Coordinate Entry Fields
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Ansoft Terms

Project Manager 

Project

Design

Design Results

Design Setup

Design Automation
•Parametric

•Optimization

•Sensitivity
•Statistical

Project Manager Window
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Ansoft Terms

Property Window 

Property Window

Property tabs

Property 

buttons
Property 

table
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Ansoft Terms

Ansoft 3D Modeler 

Edge
Vertex

Plane

Coordinate System (CS)

Origin

Face

Model

3D Modeler Window

Graphics

area Model

3D Modeler 

design tree

Context menu
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Ansoft Terms

3D Modeler Design Tree

Grouped by MaterialGrouped by MaterialGrouped by MaterialGrouped by Material

Object ViewObject ViewObject ViewObject View

Material

Object

Object Command History
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Design Windows

Design Windows
In the Ansoft Maxwell Desktop, each project can have multiple designs and each 

design is displayed in a separate window.

You can have multiple projects and design windows open at the same time.  

Also, you can have multiple views of the same design visible at the same time.

To arrange the windows, you can drag them by the title bar, and resize them by 

dragging a corner or border.  Also, you can select one of the following menu 

options: Window >CascadeWindow >CascadeWindow >CascadeWindow >Cascade, Window >Tile VerticallyWindow >Tile VerticallyWindow >Tile VerticallyWindow >Tile Vertically, or Window > Tile Window > Tile Window > Tile Window > Tile 
Horizontally.Horizontally.Horizontally.Horizontally.

To organize your Ansoft Maxwell window, you can iconize open designs.  Click 
the Iconize ** symbol in the upper right corner of the document border.  An icon 

appears in the lower part of the Ansoft Maxwell window.  If the icon is not visible, 

it may be behind another open document.  Resize any open documents as 

necessary.  Select the menu item Window > Arrange IconsWindow > Arrange IconsWindow > Arrange IconsWindow > Arrange Icons to arrange them at 

the bottom of the Ansoft Maxwell window. 

Select the menu item Window > Close AllWindow > Close AllWindow > Close AllWindow > Close All to close all open design.  You are 

prompted to SaveSaveSaveSave unsaved designs.

Design icons

Iconize

Symbol
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Toolbars

Toolbars
The toolbar buttons are shortcuts for frequently used commands. Most of the 

available toolbars are displayed in this illustration of the Ansoft Maxwell initial 

screen, but your Ansoft Maxwell window probably will not be arranged this way.  

You can customize your toolbar display in a way that is convenient for you.

Some toolbars are always displayed; other toolbars display automatically when 
you select a document of the related type.  For example, when you select a 2D 

report from the project tree, the 2D report toolbar displays.

To display or hide individual toolbars:
Right-click the Ansoft Maxwell window frame.

A list of all the toolbars is displayed.  The toolbars with a check mark 

beside them are visible; the toolbars without a check mark are hidden.  
Click the toolbar name to turn its display on or off

To make changes to the toolbars, select the menu item Tools > CustomizeTools > CustomizeTools > CustomizeTools > Customize.  See 

Customize and Arrange ToolbarsCustomize and Arrange ToolbarsCustomize and Arrange ToolbarsCustomize and Arrange Toolbars on the 

next page.

Toolbars

Ansoft 

Maxwell

panels
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Toolbars

Customize and Arrange Toolbars
To customize toolbars:

Select the menu item Tools > Customize,Tools > Customize,Tools > Customize,Tools > Customize, or right-click the Ansoft Maxwell 

window frame and click CustomizeCustomizeCustomizeCustomize at the bottom of the toolbar list.

In the Customize dialog, you can do the following:

View a Description of the toolbar commandsView a Description of the toolbar commandsView a Description of the toolbar commandsView a Description of the toolbar commands

1. Select an item from the Component pull-down list

2. Select an item from the Category list

3. Using the mouse click on the Buttons to display the 
Description

4. Click the CloseCloseCloseClose button when you are finished

Toggle the visibility of toolbarsToggle the visibility of toolbarsToggle the visibility of toolbarsToggle the visibility of toolbars

1. From the Toolbar list, toggle the check boxes to control the 

visibility of the toolbars

2. Click the CloseCloseCloseClose button when you are finished
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Overview

Ansoft Maxwell Desktop
The complex functionality built into the Maxwell 3D solvers is accessed through 

the main user interface (called the desktop). With the version 11 interface and 

later, you can model the problem in a fairly arbitrary order (rather than following 

the steps in a precise order as was required in previous versions of Maxwell). 

This flexibility allows experienced users to develop a modeling style that suits 
their preferences. Once the model is created, the automated Maxwell solution 

sequence takes over and fully controls the solution process without any 

interaction from the user. When the solution becomes available, the user can 

perform a variety of post-processing tasks as required by the design application.

Modeling Process
For users new to electromagnetic field simulation, Ansoft recommends the 

following sequence of modeling steps:

1. Based on your application, choose the type of electromagnetic analysis 

to be performed.

2. Draw the geometry of the model using the drawing space provided by 

the 3D Modeler menu and Draw menu commands available through the

Maxwell desktop interface.

3. Assign the material properties to all solid objects in the model, and 

define new material properties if materials in the default library do not 

provide the needed material.

NoteNoteNoteNote: Always make sure the material properties assigned to an object correspond 

to the real properties of the materials in the electromagnetic device that is being 

simulated. Material properties supplied in the default library are generic properties 

and may not always be substituted for actual properties.

4. Specify the field sources (excitations) and boundary conditions for your 

unique solution.

5. Define additional global parameters that you want to calculate (such as 

force, torque, inductance/capacitance, etc.).

6. Define mesh operations for special applications (such as seeding in 
areas/objects of interest).

7. Specify solution options.

8. Start the solution process.

9. When the solution becomes available, perform post processing, such as 
plotting field quantities and calculating expressions.
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Overview

Parametric Adaptive Analysis
1.1.1.1. Parametric Model GenerationParametric Model GenerationParametric Model GenerationParametric Model Generation – creating the geometry, boundaries and excitations

2.2.2.2. Analysis Setup Analysis Setup Analysis Setup Analysis Setup – defining solution setup and frequency sweeps

3.3.3.3. ResultsResultsResultsResults – creating 2D reports and field plots

4.4.4.4. Solve LoopSolve LoopSolve LoopSolve Loop - the solution process is fully automated

To understand how these processes co-exist, examine the illustration shown 

below (shown specifically for a Magnetostatic setup).

DesignDesignDesignDesign

Solution TypeSolution TypeSolution TypeSolution Type

2. Boundaries2. Boundaries2. Boundaries2. Boundaries

2. Excitations2. Excitations2. Excitations2. Excitations

3 Mesh 3 Mesh 3 Mesh 3 Mesh 

OperationsOperationsOperationsOperations

2. Analysis2. Analysis2. Analysis2. Analysis
Solution Setup

1. Parametric Model1. Parametric Model1. Parametric Model1. Parametric Model
Geometry/Materials

4. Results4. Results4. Results4. Results
2D Reports

Fields

MeshMeshMeshMesh

RefinementRefinementRefinementRefinement
SolveSolveSolveSolve

UpdateUpdateUpdateUpdate

ConvergedConvergedConvergedConverged

AnalyzeAnalyzeAnalyzeAnalyze

FinishedFinishedFinishedFinished

2. Solve Loop2. Solve Loop2. Solve Loop2. Solve Loop

NONONONO

YESYESYESYES
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Opening a Design

Opening a Maxwell project
The basic modeling entity in Maxwell is the design (model). The next level up is 

the project. A project is a collection of one or more designs (models) that is saved 

in a single *.mxwl file. A new project is automatically created when Maxwell is 

launched. As many Maxwell designs as needed can be added to a single 

Maxwell project. 

Opening a New projectOpening a New projectOpening a New projectOpening a New project

To open a new project:To open a new project:To open a new project:To open a new project:

1. In an  Ansoft Maxwell window, select the menu item File > NewFile > NewFile > NewFile > New.

To insert a Maxwell design:To insert a Maxwell design:To insert a Maxwell design:To insert a Maxwell design:

1. In an  Ansoft Maxwell window, select the menu item Project > Insert Project > Insert Project > Insert Project > Insert 
MaxwellDesignMaxwellDesignMaxwellDesignMaxwellDesign.

Opening an Existing Maxwell projectOpening an Existing Maxwell projectOpening an Existing Maxwell projectOpening an Existing Maxwell project

To open an existing project:To open an existing project:To open an existing project:To open an existing project:

1. In an Ansoft Maxwell window, select the menu File > OpenFile > OpenFile > OpenFile > Open. Use the 

Open dialog to select the project.

2. Click OpenOpenOpenOpen to open the project

Opening an Existing Project from ExplorerOpening an Existing Project from ExplorerOpening an Existing Project from ExplorerOpening an Existing Project from Explorer

You can open a project directly from the Microsoft Windows Explorer.

To open a project from Windows Explorer, do one of the followingTo open a project from Windows Explorer, do one of the followingTo open a project from Windows Explorer, do one of the followingTo open a project from Windows Explorer, do one of the following::::

Double-click on the name of the project in Windows Explorer.

Right-click the name of the project in Windows Explorer and select 

OpenOpenOpenOpen from the shortcut menu.
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Set Solution Type

Set Solution Type

To set the solution type:To set the solution type:To set the solution type:To set the solution type:

1. Select the menu item Maxwell > Solution TypeMaxwell > Solution TypeMaxwell > Solution TypeMaxwell > Solution Type

2. Solution Type Window:

1. Choose one of the following:

1.1.1.1. MagnetostaticMagnetostaticMagnetostaticMagnetostatic

2.2.2.2. Eddy CurrentEddy CurrentEddy CurrentEddy Current

3.3.3.3. TransientTransientTransientTransient

4.4.4.4. Electric (Electrostatic, DC Conduction)Electric (Electrostatic, DC Conduction)Electric (Electrostatic, DC Conduction)Electric (Electrostatic, DC Conduction)

2. Click the OKOKOKOK button
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2.1
Magnetostatic Analysis
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Magnetostatic Analysis
Magnetostatic Analysis is performed by choosing the Magnetostatic solution type.

Applications that use Magnetostatic Analysis can be solenoids, inductors, 

motors, actuators, permanent magnets, stray field calculations and many others.

Overview
The magnetostatic solver computes static (DC) magnetic fields.

All objects are stationary.

The source of the static magnetic field can be:

DC current in conductors

Permanent magnets

Static magnetic fields represented by external boundary conditions.

The quantity solved is the magnetic field (H).

Current density (J) and magnetic flux density (B) are automatically calculated 

from the magnetic field (H).

Derived quantities such as forces, torques, energy, and inductances may be 
calculated from these basic field quantities.

Material permeabilities can be nonlinear and/or anisotropic.
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2.1
Magnetostatic Analysis
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Setup
The options in the project tree for a magnetostatic simulation control all the 

simulation setup parameters.

Notice that right-clicking on any of the options will open a menu with 

important options for each step of the simulation setup.

The Model definition refers to the geometry

and material definition.

Boundaries and Excitations refer to the 

specific boundaries and excitations available 
in a magnetostatic simulation.

Parameters are values that the solver will

automatically calculate after finding the field

solution.

Mesh Operations are discussed in a separate

section.

Analysis defines the solution setup.

Optimetrics defines any automatic variational

analyses.

Results and Field overlays are discussed in a

separate section.

These options are displayed in an order that can be followed in creating a new 
Magnetostatic simulation.  This is a general purpose order that goes linearly 

through simulation setup, analysis, and post-processing.  

However, in some cases it is acceptable to work out of the defined order.  This is 
particularly true when defining results, field overlays, or calculated quantities.  It 

is important to think of results when defining the problem setup so that the 

desired quantities may be obtained in a sufficient manner.  Notice, however, that 

the field calculator is not available until a solution setup is defined.
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2.1
Magnetostatic Analysis
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Magnetostatic Material Definition
In a Magnetostatic simulation, the following parameters may be defined for a 

material:

Relative PermeabilityRelative PermeabilityRelative PermeabilityRelative Permeability (can be Anisotropic and/or Nonlinear, or Simple)

Relative permeability along with the Magnetic Coercivity determine 
the magnetic properties of the material.

Bulk ConductivityBulk ConductivityBulk ConductivityBulk Conductivity (can be Anisotropic or Simple)

Bulk Conductivity is used in determining the current distribution in 

current carrying conductors – it has no influence in the magnetic part 

of the solution process.

Magnetic Magnetic Magnetic Magnetic CoercivityCoercivityCoercivityCoercivity (defined as a vector magnitude and direction)

Magnetic Coercivity is used to define the permanent magnetization 

of magnetic materials.  When a non-zero magnitude is entered, the 

directional entries are visible.  The direction (like all directional 
material properties) are determined by the coordinate system type 

and the object orientation.

Composition Composition Composition Composition (can be Solid or Lamination)

Setting Composition to Lamination creates an anisotropic 

magnetization effect.  This is discussed in the Anisotropic Material 
example.
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Magnetostatic Boundary Conditions
DefaultDefaultDefaultDefault – The default boundary conditions for the Magnetostatic solver are:

NaturalNaturalNaturalNatural boundaries on the interface between objects.

- This means that the H Field is continuous across the boundary.

NeumannNeumannNeumannNeumann boundaries on the outer boundaries.
- This means that the H Field is tangential to the boundary and flux cannot 

cross it.

Zero Tangential H FieldZero Tangential H FieldZero Tangential H FieldZero Tangential H Field – This boundary is often used to model an applied 

uniform, external field.  This would model outer boundaries of the Region that are 
perpendicular to the applied field.  In this case, the boundary should be placed far 

from the structure so that the simulation is not over-defined.  This is equivalent to 

the even symmetry boundary definition.  

Tangential H FieldTangential H FieldTangential H FieldTangential H Field – This boundary is used primarily to model an applied uniform, 

external field.  This would model outer boundaries of the Region that have a 

defined tangential magnetic field.  This boundary should always be placed far 

from the structure so that the simulation is not over-defined.  Faces must be 

planar and must be defined one at a time, due to the U-V field definition on each 
face.

To apply a uniform field along any orthogonal axis of a bounding box, first, 

apply a Zero Tangential H Field on the top and bottom faces (with respect 

to the direction of the desired axis) of the box.  Then apply a Tangential H 

Field to each side face – define each U vector to be parallel to the selected 
axis (the V vector does not matter because no field will exist in that 

direction), and assign the value of U with a constant value.  The field will be 

in the direction of the selected axis (perpendicular to the top and bottom 

faces), and will have a constant value at the boundaries of the solution 
region.

Note that it is very easy to create impossible field assignments with these 

boundary conditions.  If your simulation does not converge when using 

these boundaries, try the boundary conditions without any objects included 

to see if the boundaries are assigned correctly (the simulation will have 
difficulties converging if boundaries are incorrect).
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Magnetostatic Boundary Conditions (Continued)
InsulatingInsulatingInsulatingInsulating – This boundary defines a thin, perfectly insulating sheet between 

touching conductors.  This is particularly useful to separate coils from magnetic 

steel (defined on surfaces between the two objects), but there are many other 

applications.

SymmetrySymmetrySymmetrySymmetry – There are two magnetic symmetries – odd symmetry (flux tangential) 

and even symmetry (flux normal).  Odd symmetry defines H to be tangential to 

the boundary (this is equivalent to the default boundary condition on the outer 

boundary).  Even symmetry defines H to be normal to the boundary (this is 
equivalent to the Zero Tangential H Field boundary condition).  Remember that 

geometric symmetry may not mean magnetic symmetry in all cases. Symmetry 

boundaries enable you to model only part of a structure, which reduces the size 

or complexity of your design, thereby shortening the solution time. Other 

considerations for a Symmetry boundary condition:

A plane of symmetry must be exposed to the background.

A plane of symmetry must not cut through an object drawn in the 3D 

Modeler window.

A plane of symmetry must be defined on a planar surface.

Only three orthogonal symmetry planes can be defined in a problem

Master/SlaveMaster/SlaveMaster/SlaveMaster/Slave – This boundary condition is also known as a matching boundary 

condition because it matches the magnetic field at the slave boundary to the field 
at the master boundary.  The geometry must be identical on each face (the mesh 

needs to be identical, but the solver takes care of this requirement for matched 

geometries) and the faces need to be planar.  It is required to define a U-V 

coordinate system along each face to properly map the matched boundary as 

desired.  Master and Slave boundaries enable you to model only one period of a 
periodic structure, which will reduce the size of a design.  Example applications 

are periodic rotational machines or infinite arrays.
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Magnetostatic Excitations
Typical sources for magnetostatic field problems include voltage, current, and 

current density. When applying the sources for the magnetic field problems, the 

applied current distribution must be divergence free in the entire space of the 

solution as it is physical for quasi-stationary conduction current density 

distributions. Thus, the conduction path(s) for the applied current distributions 
must be closed when totally contained within the solution space for the problem, 

or must begin and end at the boundaries. 

Permanent Magnets and externally applied magnetic fields can also act as 
sources for a magnetostatic analysis, however, those are defined elsewhere.

Voltage Excitations Voltage Excitations Voltage Excitations Voltage Excitations ---- These are used in conjunction with the material conductivity 

to define the current through a solid conductor.  Either multiple Voltage 

excitations can be used to define a voltage difference across two faces of a 
conductor (creating a current) or a Voltage Drop can be defined on a 2D sheet 

object to signify the voltage drop around a conductive loop.

Current ExcitationsCurrent ExcitationsCurrent ExcitationsCurrent Excitations - This excitation can be assigned on any conductor to define 
the total current (amp-turns) through the cross-section of a loop or to define the 

current into and out of the opposing, external faces of a conducting object.  This 

is a very general purpose excitation that comes in two flavors – Solid or Stranded.  

More information about Stranded Magnetostatic Current excitations (along with 

an example and explanation) can be found in the Magnetostatic Switched 
Reluctance Motor example.

Current DensityCurrent DensityCurrent DensityCurrent Density - These excitations are used to define a known current density 

throughout an object and must be used with a Current Density Terminal.  The 
Current Density is defined on the 3D object, and the Terminal is defined on either 

an internal cross-sectional sheet, or on all external cross-sectional faces.
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Parameters
There are three parameters that can be

automatically calculated in a 

Magnetostatic simulation – ForceForceForceForce, 

TorqueTorqueTorqueTorque, and Inductance MatrixMatrixMatrixMatrix.

All three quantities are computed 

directly from the magnetic field solution.

Force and torque can be calculated with
two different methods - Virtual or Lorentz

(Lorentz cannot be used on magnetic 

materials).

Inductance Matrix has many post-processing options available – this is discussed 

in detail in the Magnetostatic Inductance Matrix example.

The results of any parameters can be found by selecting Maxwell > Results > Maxwell > Results > Maxwell > Results > Maxwell > Results > 
Solution DataSolution DataSolution DataSolution Data………… or by clicking on the        icon.

Further results can be obtained manually through the field calculator.

Mesh Operations
Mesh operations are described in detail in the Mesh operations section.

Remember that the Magnetostatic solver has an adaptive mesh solution, so 
excessive mesh operations are not usually required.  It can often be worse to 

over-define the mesh than to not define mesh operations at all (it will take longer 

to solve, and it will be more difficult to adapt correctly).
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Solution Setup
The solution setup defines the parameters used for solving the simulation.

Add a solution setup by selecting Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution 
SetupSetupSetupSetup………… or click on the       icon.

The following window appears with the General Setup parameters.

You can NameNameNameName the setup, and you can create multiple setups if you desire (by
repeating this procedure).

Maximum Number of PassesMaximum Number of PassesMaximum Number of PassesMaximum Number of Passes defines a limit to the number of adaptively refined 

passes that the solver performs (the default value is 10).

Percent ErrorPercent ErrorPercent ErrorPercent Error is the error goal for both the Error Energy and Delta Energy.

Solve Fields OnlySolve Fields OnlySolve Fields OnlySolve Fields Only ignores any defined parameters if checked.

Solve MatrixSolve MatrixSolve MatrixSolve Matrix has the options of calculating the matrix after the last solved pass or 

calculating the matrix only if the solution converges.

An option is included to display one Force or Torque parameter in the 

Convergence table.
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Solution Setup (Continued)
The second tab of the Solution Setup contains information about Convergence.

Refinement Per PassRefinement Per PassRefinement Per PassRefinement Per Pass defines the number of tetrahedral elements added during 

mesh refinement as a percentage of the previous pass (30% is the default).

Minimum Number of PassesMinimum Number of PassesMinimum Number of PassesMinimum Number of Passes defines the minimum number of adaptive passes 

before the solution stops - if there is a conflict, this value is over-ridden by 

Maximum Number of Passes (the default value is 2).

Minimum Converged PassesMinimum Converged PassesMinimum Converged PassesMinimum Converged Passes defines the minimum number of adaptive passes 

that have been converged (with respect to the Percent error) before the solution 

stops (the default value is 1).

Use Output Variable ConvergenceUse Output Variable ConvergenceUse Output Variable ConvergenceUse Output Variable Convergence is an option to include a defined output 
variable as an additional convergence criterion with a specified maximum percent 

change per pass (an output variable must be defined for this option to be 

available).
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Solution Setup (Continued)
The third tab of the Solution Setup contains information about the Solver.

Nonlinear ResidualNonlinear ResidualNonlinear ResidualNonlinear Residual defines how precisely the nonlinear solution must define the 
B-H nonlinear operating points (the default value is 0.01).

Solver TypeSolver TypeSolver TypeSolver Type has options for the DirectDirectDirectDirect or ICCG ICCG ICCG ICCG solvers (Direct is the default).

Permeability OptionPermeability OptionPermeability OptionPermeability Option allows the nonlinear B-H operating points either to be 

calculated by the solver from the Nonlinear BNonlinear BNonlinear BNonlinear B----H curveH curveH curveH curve or to use frozen 

permeabilities From LinkFrom LinkFrom LinkFrom Link – the linked solution must have the exact same 
geometry as the current simulation (Nonlinear B-H curve is the default).

Magnetization OptionMagnetization OptionMagnetization OptionMagnetization Option allows the permanent magnetization to be determined from 

the Nonlinear BNonlinear BNonlinear BNonlinear B----H curveH curveH curveH curve or to use demagnetized values From LinkFrom LinkFrom LinkFrom Link - where the 

linked solution selected Compute demagnetized operating pointsCompute demagnetized operating pointsCompute demagnetized operating pointsCompute demagnetized operating points - the linked 
solution must have the exact same geometry (Nonlinear B-H curve is the default).

Import MeshImport MeshImport MeshImport Mesh allows the initial mesh to be imported from another solution – the 

linked solution must have the exact same geometry as the current simulation.

Setup LinkSetup LinkSetup LinkSetup Link must be defined when selecting From LinkFrom LinkFrom LinkFrom Link or Import MeshImport MeshImport MeshImport Mesh.
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Magnetostatic Solution Process
Unlike pre-processing, the solution process is very automated.  Once the 

problem has been defined properly, Maxwell will take over and step through 

several stages of the solution process.  To start the solution process, right-click 

on Analysis in the Maxwell Project Tree and select Analyze.

Initial Setup

Adaptive Solution

Nonlinear Convergence

(Changing permeability)

Refine Mesh

Converged or Number of Passes

Stop Field Solution

Calculate Parameters

Solution Convergence ?

Force/Torque Calculation
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Eddy Current Analysis
Eddy Current Analysis is performed by choosing the Eddy Current solution type.

Applications that use Eddy Current Analysis can be solenoids, inductors, motors, 

stray field calculations and many others.

Overview
The eddy current solver computes steady-state, time-varying (AC) magnetic 

fields at a given frequency – this is a frequency domain solution.

All objects are stationary.

The source of the static magnetic field can be:

Sinusoidal AC current (peak) in conductors.

Time-varying external magnetic fields represented by external boundary 
conditions.

The quantities solved are the magnetic field (H) and the magnetic scalar potential 

(Ω).

Current density (J) and magnetic flux density (B) are automatically calculated 

from the magnetic field (H).

Derived quantities such as forces, torques, energy, and inductances may be 

calculated from these basic field quantities.

Material permeabilities and conductivities can be anisotropic, but must be linear.
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Setup
The options in the project tree for a eddy current simulation control all the 

simulation setup parameters.

Notice that right-clicking on any of the options will open a menu with 

important options for each step of the simulation setup.

The Model definition refers to the geometry

and material definition.

Boundaries and Excitations refer to the 

specific boundaries and excitations available 
in a eddy current simulation.

Parameters are values that the solver will

automatically calculate after finding the field

solution.

Mesh Operations are discussed in a separate

section.

Analysis defines the solution setup.

Optimetrics defines any automatic variational

analyses.

Results and Field overlays are discussed in a

separate section.

These options are displayed in an order that can be followed in creating a new 
Eddy Current simulation.  This is a general purpose order that goes linearly 

through simulation setup, analysis, and post-processing.  

However, in some cases it is acceptable to work out of the defined order.  This is 
particularly true when defining results, field overlays, or calculated quantities.  It 

is important to think of results when defining the problem setup so that the 

desired quantities may be obtained in a sufficient manner.  Notice, however, that 

the field calculator is not available until a solution setup is defined.
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Eddy Current Material Definition
In an Eddy Current simulation, the following parameters may be defined for a 

material:

Relative PermittivityRelative PermittivityRelative PermittivityRelative Permittivity (can be Anisotropic or Simple)

Relative Permittivity effects the solution when displacement currents 
are considered in an object.

Relative PermeabilityRelative PermeabilityRelative PermeabilityRelative Permeability (can be Anisotropic or Simple)

Relative Permeability along with the Bulk Conductivity determine the 

time-varying magnetic properties of the material.

Bulk ConductivityBulk ConductivityBulk ConductivityBulk Conductivity (can be Anisotropic or Simple)

Bulk Conductivity is used both in determining the current distribution 

in current carrying conductors and in calculating eddy currents and 

the resulting magnetic field solution.

Dielectric Loss TangentDielectric Loss TangentDielectric Loss TangentDielectric Loss Tangent (can be Anisotropic or Simple)

Dielectric Loss Tangent controls the ratio of imaginary and real

permittivities.

Magnetic Loss TangentMagnetic Loss TangentMagnetic Loss TangentMagnetic Loss Tangent (can be Anisotropic or Simple)

Magnetic Loss Tangent controls the ratio of imaginary and real 
permeabilities.
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Eddy Current Boundary Conditions
DefaultDefaultDefaultDefault – The default boundary conditions for the Eddy Current solver are:

NaturalNaturalNaturalNatural boundaries on the interface between objects.

- This means that the H Field is continuous across the boundary.

NeumannNeumannNeumannNeumann boundaries on the outer boundaries.
- This means that the H Field is tangential to the boundary and flux cannot 

cross it.

Zero Tangential H FieldZero Tangential H FieldZero Tangential H FieldZero Tangential H Field – This boundary (similar to the Magnetostatic version) is 

often used to model an applied uniform, external field.  This would model outer 
boundaries of the Region that are perpendicular to the applied field.  In this case, 

the boundary should be placed far from the structure so that the simulation is not 

over-defined.  This is equivalent to the even symmetry boundary definition.  

Tangential H FieldTangential H FieldTangential H FieldTangential H Field – This boundary (similar to the Magnetostatic version) is used 

primarily to model an applied uniform, external field.  This would model outer 

boundaries of the Region that have a defined tangential magnetic field.  This 

boundary should always be placed far from the structure so that the simulation is 

not over-defined.  Faces must be planar and must be defined one at a time, due 
to the U-V field definition on each face.

To apply a uniform field along any orthogonal axis of a bounding box, first, 

apply a Zero Tangential H Field on the top and bottom faces (with respect 

to the direction of the axis) of the box.  Then apply a Tangential H Field to 

each side face – define each U vector to be parallel to the selected axis (the 
V vector does not matter because no field will exist in that direction), and 

assign the real and imaginary values of U with constant values. The field 

will be in the direction of the selected axis (perpendicular to the top and 

bottom faces), and will have a constant value away from the defined 
objects in the simulation.

Note that it is very easy to create impossible field assignments with these 

boundary conditions.  If your simulation does not converge when using 

these boundaries, try the boundary conditions without any objects included 

to see if the boundaries are assigned correctly (the simulation will have 
difficulties converging if boundaries are incorrect).
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Eddy Current Boundary Conditions (Continued)
InsulatingInsulatingInsulatingInsulating – This boundary defines a thin, perfectly insulating sheet between 

touching conductors.  This is particularly useful to separate coils from magnetic 

steel (defined on surfaces between the two objects), but there are many other 

applications.

SymmetrySymmetrySymmetrySymmetry – There are two magnetic symmetries – odd symmetry (flux tangential) 

and even symmetry (flux normal).  Odd symmetry defines H to be tangential to 

the boundary (this is equivalent to the default boundary condition on the outer 

boundary).  Even symmetry defines H to be normal to the boundary (this is 
equivalent to the Zero Tangential H Field boundary condition).  Remember that 

geometric symmetry may not mean magnetic symmetry in all cases. Symmetry 

boundaries enable you to model only part of a structure, which reduces the size 

or complexity of your design, thereby shortening the solution time. Other 

considerations for a Symmetry boundary condition are the same as for a 
Magnetostatic symmetry boundary.

Master/SlaveMaster/SlaveMaster/SlaveMaster/Slave – This boundary condition is also known as a matching boundary 

condition because it matches the magnetic field at the slave boundary to the field 
at the master boundary.  The geometry must be identical on each face (the mesh 

needs to be identical, but the solver takes care of this requirement for matched 

geometries) and the faces need to be planar.  It is required to define a U-V 

coordinate system along each face to properly map the matched boundary as 

desired.  Master and Slave boundaries enable you to model only one period of a 
periodic structure, which will reduce the size of a design.  Example applications 

are periodic rotational machines or infinite arrays.

RadiationRadiationRadiationRadiation – This boundary condition is specific to the Eddy Current solver. See 

the discussion of the Radiation boundary in the Radiation Boundary example.

ImpedanceImpedanceImpedanceImpedance – This boundary can model induced currents within excluded objects 

without explicitly solving within the objects.  This can decrease simulation time 

because the difficult to mesh areas near the surface of objects can be ignored 
and approximated with this boundary.  By excluding the object (accomplished by 

deselecting Solve Inside in the object properties), there will be no solution inside 

the object.  This approximation is good for good conductors (where the skin depth 

is less than half the width of the excluded conductor).
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Eddy Current Excitations
Typical sources for eddy current problems include current and current density. In 

applying the sources for the magnetic field problems, keep in mind that the 

applied current distribution must be divergence free in the entire space of the 

solution as it is physical for (quasi) stationary conduction current density 

distributions. Thus, the conduction paths(s) for the applied current distributions 
must be closed when totally contained within the solution space for the problem 

or must begin and end at the boundaries. The total current applied to conductors 

that touch the boundaries doesn't require the existence of terminals at the ends 

where the current is applied, the respective planar surfaces of the conductors in 

the plane of the region (background) can be used to apply the excitations. 

Current ExcitationsCurrent ExcitationsCurrent ExcitationsCurrent Excitations - This excitation can be assigned on any conductor to define 

the total peak current (amp-turns) through the cross-section of a loop or to define 

the current into and out of the opposing, external faces of a conducting object.  
This is a very general purpose excitation that comes in two flavors – Solid or 

Stranded.  More information about Stranded Current excitations (along with a 

Magnetostatic example and explanation) can be found in the Magnetostatic 

Switched Reluctance Motor example.  The only difference between the use of 

stranded and solid conductors between the magnetostatic solver and the eddy 
current solver, is that in the eddy current solver eddy effects are not considered in 

stranded conductors, but not in solid conductors.

Current DensityCurrent DensityCurrent DensityCurrent Density - These excitations are used to define a known current density 
throughout an object and must be used with a Current Density Terminal.  The 

peak Current Density (magnitude and phase) is defined on the 3D object, and the 

Terminal is defined on either an internal cross-sectional sheet, or on all external 

cross-sectional faces.
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Parameters
There are three parameters that can be

automatically calculated in an 

Eddy Current simulation – ForceForceForceForce, 

TorqueTorqueTorqueTorque, and Inductance MatrixMatrixMatrixMatrix.

All three quantities are computed 

directly from the magnetic field solution.

Force and torque can be calculated with
two different methods - Virtual or Lorentz

(Lorentz cannot be used on magnetic 

materials).

The results of any parameters can be found by selecting Maxwell > Results > Maxwell > Results > Maxwell > Results > Maxwell > Results > 
Solution DataSolution DataSolution DataSolution Data………… or by clicking on the        icon.

Further results can be obtained manually through the field calculator.

Mesh Operations
Mesh operations are described in detail in the Mesh operations section.

Remember that the Eddy Current solver has an adaptive mesh solution, so 

excessive mesh operations are not always required.  It can often be worse to 

over-define the mesh than to not define mesh operations at all (it will take longer 

to solve, and it will be more difficult to adapt correctly).

However, it is very important to mesh properly to account for currents with small 

skin depths – this is important on solid conducting objects.
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Solution Setup
The solution setup defines the parameters used for solving the simulation.

Add a solution setup by selecting Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution 
SetupSetupSetupSetup………… or click on the       icon.

The following window appears with the General Setup parameters.

You can NameNameNameName the setup, and you can create multiple setups if you desire (by
repeating this procedure).

Maximum Number of PassesMaximum Number of PassesMaximum Number of PassesMaximum Number of Passes defines a limit to the number of adaptively refined 

passes that the solver performs (the default value is 10).

Percent ErrorPercent ErrorPercent ErrorPercent Error is the error goal for both the Error Energy and Delta Energy.

Solve Fields OnlySolve Fields OnlySolve Fields OnlySolve Fields Only ignores any defined parameters if checked.

Solve MatrixSolve MatrixSolve MatrixSolve Matrix has the options of calculating the matrix after the last solved pass or 

calculating the matrix only if the solution converges.

An option is included to display one Force or Torque parameter in the 

Convergence table.
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Solution Setup (Continued)
The second tab of the Solution Setup contains information about Convergence.

Refinement Per PassRefinement Per PassRefinement Per PassRefinement Per Pass defines the number of tetrahedral elements added during 

mesh refinement as a percentage of the previous pass (30% is the default).

Minimum Number of PassesMinimum Number of PassesMinimum Number of PassesMinimum Number of Passes defines the minimum number of adaptive passes 

before the solution stops - if there is a conflict, this value is over-ridden by 

Maximum Number of Passes (the default value is 2).

Minimum Converged PassesMinimum Converged PassesMinimum Converged PassesMinimum Converged Passes defines the minimum number of adaptive passes 

that have been converged (with respect to the Percent error) before the solution 

stops (the default value is 1).

Use Output Variable ConvergenceUse Output Variable ConvergenceUse Output Variable ConvergenceUse Output Variable Convergence is an option to include a defined output 
variable as an additional convergence criterion with a specified maximum percent 

change per pass (an output variable must be defined for this option to be 

available).
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Solution Setup (Continued)
The third tab of the Solution Setup contains information about the Solver.

Linear ResidualLinear ResidualLinear ResidualLinear Residual defines the residual limit of an iterative solver that is 

automatically used if necessary, but the default solver for eddy current 

simulations is the direct solver where this limit has no significance (the default 

value is 1e-8).

Adaptive FrequencyAdaptive FrequencyAdaptive FrequencyAdaptive Frequency defines the frequency at which the mesh is constructed and 

adapted, and at which solution is obtained (the default value is 60 Hz).

Import MeshImport MeshImport MeshImport Mesh allows the initial mesh to be imported from another solution – the 

linked solution must have the exact same geometry as the current simulation.

Setup LinkSetup LinkSetup LinkSetup Link must be defined when selecting Import MeshImport MeshImport MeshImport Mesh.
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Solution Setup (Continued)
The fourth tab of the Solution Setup contains information about an optional 

Frequency Sweep.

Define the sweep (Type, Start, Stop, StepType, Start, Stop, StepType, Start, Stop, StepType, Start, Stop, Step) in the left panel.

Check Save Fields (All Frequencies)Save Fields (All Frequencies)Save Fields (All Frequencies)Save Fields (All Frequencies) to save the fields for all frequencies in this 
sweep definition.

Select Add to List >>Add to List >>Add to List >>Add to List >> to place this sweep definition in the Sweep List (the Sweep 

List is displayed in the right panel).

Edit any entries in the Sweep List to adjust solution frequencies or whether to 

save fields at specific frequencies in the list.
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Eddy Current Solution Process
Unlike pre-processing, the solution process is very automated.  Once the 

problem has been defined properly, Maxwell will take over and step through 

several stages of the solution process.  To start the solution process, right-click 

on Analysis in the Maxwell Project Tree and select Analyze.

Initial Setup

Adaptive Solution

Refine Mesh

Converged or Number of Passes

Stop Field Solution

Calculate Parameters

Solution Convergence ?

Frequency Sweep ?

Done

Next Frequency
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Transient Analysis
Transient Analysis is performed by choosing the Transient solution type.

Applications that use Transient Analysis can be solenoids, inductors, motors, 

actuators, permanent magnets and many others.

Overview
The Transient solver computes magnetic fields in the time domain

(instantaneously at each time step).

The solver formulation is based on a current vector potential in solid conductors, 

and a scalar potential over the entire field domain.

The source of the static magnetic field can be:

Arbitrary time-varying current in conductors.

Permanent magnets.

Field Quantities are strongly coupled with circuit equations to allow voltage 

sources and/or external driving circuits.

The quantity solved is the magnetic field (H) and the current density (J) while 

magnetic flux density (B) is automatically calculated from the H-field.

Derived quantities such as forces, torques, flux linkage and core loss may be 

calculated from these basic field quantities.

Material permeabilities can be nonlinear and/or anisotropic.

Permanent magnets are considered.

Excitations can be sinusoidal or non-sinusoidal including:

Voltages and currents applied to windings.

External circuits attached to windings.

Permanent magnets.
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Setup
The options in the project tree for a transient simulation control all the simulation 

setup parameters.

Notice that right-clicking on any of the options will open a menu with 

important options for each step of the simulation setup.

The Model definition refers to the geometry

and material, as well as motion definitions.

Boundaries and Excitations refer to the 

specific boundaries and excitations available 
in a transient simulation.

Parameters are values that the solver will

automatically calculate after finding the field

solution.

Mesh Operations are discussed in a separate

section.

Analysis defines the solution setup.

Optimetrics defines any automatic variational

analyses.

Results and Field overlays are discussed in a

separate section.

These options are displayed in an order that can be followed in creating a new 
Transient simulation.  This is a general purpose order that goes linearly through 

simulation setup, analysis, and post-processing.  

However, in some cases it is acceptable to work out of the defined order.  This is 
particularly true when defining results, field overlays, or calculated quantities.  It 

is important to think of results when defining the problem setup so that the 

desired quantities may be obtained in a sufficient manner.  Notice, however, that 

the field calculator is not available until a solution setup is defined.
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Transient Material Definition
In a Transient simulation, the following parameters may be defined for a material:

Relative PermeabilityRelative PermeabilityRelative PermeabilityRelative Permeability (can be Anisotropic and/or Nonlinear, or Simple)

Relative Permeability plays a large role in determining the magnetic 

field solution.

Bulk ConductivityBulk ConductivityBulk ConductivityBulk Conductivity (can be Anisotropic or Simple)

Bulk Conductivity is used both in determining the current distribution 

in current carrying conductors and in finding the eddy currents in 

solid conductors, which affect the magnetic solution.

Magnetic Magnetic Magnetic Magnetic CoercivityCoercivityCoercivityCoercivity (defined as a vector magnitude and direction)

Magnetic Coercivity is used to define the permanent magnetization 

of magnetic materials.  When a non-zero magnitude is entered, the 

directional entries are visible.  The direction (like all directional 

material properties) are determined by the coordinate system type 
and the object orientation.

Core Loss TypeCore Loss TypeCore Loss TypeCore Loss Type (can be Electrical Steel, Power Ferrite, or None)

Mass DensityMass DensityMass DensityMass Density

Composition Composition Composition Composition (can be Solid or Lamination)

Setting Composition to Lamination creates an anisotropic 

magnetization effect.  This is discussed in the Magnetostatic

Anisotropic Material example.
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Transient Boundary Conditions
DefaultDefaultDefaultDefault – The default boundary conditions for the Transient solver are:

NaturalNaturalNaturalNatural boundaries on the interface between objects.

- This means that the H Field is continuous across the boundary.

NeumannNeumannNeumannNeumann boundaries on the outer boundaries.
- This means that the H Field is tangential to the boundary and flux cannot 

cross it.

Zero Tangential H FieldZero Tangential H FieldZero Tangential H FieldZero Tangential H Field – This boundary acts equivalently on the field as the even 

symmetry boundary, but is used in special cases only.  Use the even symmetry 
boundary to model symmetries with normal H fields to the symmetry plane.

InsulatingInsulatingInsulatingInsulating – This boundary defines a thin, perfectly insulating sheet between 

touching conductors.  This is particularly useful to separate coils from magnetic 
steel (defined on surfaces between the two objects), but there are many other 

applications.

SymmetrySymmetrySymmetrySymmetry – There are two magnetic symmetries – odd symmetry (flux tangential) 

and even symmetry (flux normal).  Odd symmetry defines H to be tangential to 
the boundary (this is equivalent to the default boundary condition on the outer 

boundary).  Even symmetry defines H to be normal to the boundary (this is 

equivalent Zero Tangential H Field boundary condition).  Remember that 

geometric symmetry may not mean magnetic symmetry in all cases. Symmetry 
boundaries enable you to model only part of a structure, which reduces the size 

or complexity of your design, thereby shortening the solution time. Other 

considerations for a Symmetry boundary condition are the same as for a 

Magnetostatic symmetry boundary.

Master/SlaveMaster/SlaveMaster/SlaveMaster/Slave – This boundary condition is also known as a matching boundary 

condition because it matches the magnetic field at the slave boundary to the field 

at the master boundary.  The geometry must be identical on each face (the mesh 

needs to be identical, but the solver takes care of this requirement for matched 

geometries) and the faces need to be planar.  It is required to define a U-V 
coordinate system along each face to properly map the matched boundary as 

desired.  Master and Slave boundaries enable you to model only one period of a 

periodic structure, which will reduce the size of a design.  Example applications 

are periodic rotational machines or infinite arrays.
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Transient Excitations
Typical sources for transient field problems include coil terminals of type voltage, 

current or external circuit. When applying the sources for the magnetic field 

problems, the applied current distribution must be divergence free in the entire 

space of the solution as it is physical for quasi-stationary conduction current 

density distributions. Thus, the conduction path(s) for the applied current 
distributions must be closed when totally contained within the solution space for 

the problem, or must begin and end at the boundaries. 

Permanent Magnets can also act as sources for a transient analysis, however, 
those are defined elsewhere.

Coil Terminals Coil Terminals Coil Terminals Coil Terminals –––– Coil terminals are defined to designate the cross sectional faces 

of the 3D conductors.  These can either be located internally to a closed loop, or 

on the external faces of a conduction path.  The coil terminals are grouped into a 
Winding that controls the current in one or multiple conduction paths.  The only 

things that are defined by the Coil Terminals are as follows:

Number of conductors (solid windings require 1 conductor)

Direction of the current

A cross section of the conductor

WindingsWindingsWindingsWindings – Windings control the current flowing through the conductors and are 

therefore crucial to the magnetic solution.  There are three different types of 
winding:

CurrentCurrentCurrentCurrent – defines a specified functional current through the conducting 

paths.

VoltageVoltageVoltageVoltage – defines a specified functional voltage across the coil terminals 

(and a series resistance and inductance).

ExternalExternalExternalExternal – defines that an external circuit will control the current and voltage 

associated with the conducting path.

Coil terminals must be added to a Winding to complete the excitation setup.

Coil terminals will automatically report flux linkage and induced voltage vs. time 

in the 2D reporter.
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Winding Setup
Assign a coil terminal to a winding by either:

Right-clicking on the winding and choosing Add TerminalsAdd TerminalsAdd TerminalsAdd Terminals…………

or

Right-clicking on the terminal and choosing Add to WindingAdd to WindingAdd to WindingAdd to Winding…………

Group coil terminals by adding them to the same winding.

Grouped conductors are considered in series – the defined current goes through 
each conductor, voltage is defined across all conductors plus additional 

resistance and/or inductance  – total winding inductance is treated as the sum of 

each coil’s inductance.

In the Winding setup:

Define the Winding to be the desired Type and Solid vs. Stranded.

Then, define the necessary parameters – current or voltage can be a 

function of time in their respective source types.  Resistance and 

inductance are available for voltage sources (to determine the current), and 
are considered in series with winding.
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External Circuits
Step1:  Open Maxwell Circuit Editor

(Windows Start Menu > Programs > Ansoft > Windows Start Menu > Programs > Ansoft > Windows Start Menu > Programs > Ansoft > Windows Start Menu > Programs > Ansoft > 
Maxwell 11 > Maxwell Circuit EditorMaxwell 11 > Maxwell Circuit EditorMaxwell 11 > Maxwell Circuit EditorMaxwell 11 > Maxwell Circuit Editor)

Step 2:  Create Circuit in Maxwell Circuit Editor Schematic

In the editor, each winding should appear as a Winding element, with a 

matching name for each winding – i.e. Winding1 in the transient simulation 

would require Winding1 in the schematic (displayed as LWinding1 on the 

schematic sheet).

Step 3:  Export netlist from the circuit editor (Maxwell Circuit > Export Maxwell Circuit > Export Maxwell Circuit > Export Maxwell Circuit > Export NetlistNetlistNetlistNetlist).

Save the Circuit Editor project so that you can edit your circuit later.

Step 4:  Import the netlist into Maxwell (Maxwell > Excitations > External Circuit > Maxwell > Excitations > External Circuit > Maxwell > Excitations > External Circuit > Maxwell > Excitations > External Circuit > 
Edit External CircuitEdit External CircuitEdit External CircuitEdit External Circuit…………)

Choose Import CircuitImport CircuitImport CircuitImport Circuit………… to import the netlist.

You must re-import the netlist every time that you make a change to the 

circuit, otherwise the change will not take effect.
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Parameters
There are two parameters that can be

automatically calculated in a Transient 

simulation – Force Force Force Force and TorqueTorqueTorqueTorque.

Both quantities are computed 

directly from the magnetic field solution.

Force and torque are calculated with the 

Virtual work method.

With the motion setup, a force or torque 

associated with the translational or

rotational motion is automatically 
calculated – this force or torque (from the

motion setup) may or may not be exactly equal to a similar parameter assigned 

on the same set of moving objects.

The results of the parameters are not located in the solution results for a transient 
simulation – however, they can be obtained by creating a 2D report to find the 

parameter values as a function of time.

Further results can be obtained manually through the field calculator.

Mesh Operations
Mesh operations are described in detail in the Mesh operations section.

Remember that the Transient solver does not have an adaptive mesh solution, so 

significant, intelligent mesh operations are required.  There are techniques to 

obtain a more defined mesh, such as linking a transient simulation to the mesh 

from a Magnetostatic simulation.  Also, skin-depth meshing can be very important 
if solid conductors have significant eddy effects.
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Solution Setup
The solution setup defines the parameters used for solving the simulation.

Add a solution setup by selecting Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution 
SetupSetupSetupSetup………… or click on the       icon.

The following window appears with the General Setup parameters.

You can NameNameNameName the setup, and you can create multiple setups if you desire (by

repeating this procedure).

Stop timeStop timeStop timeStop time indicates the transient simulation time at which the simulation will stop.

Time stepTime stepTime stepTime step indicates the discrete lengths of time used in the transient simulation.

Notice that the general information is related to the transient nature of this 

simulation – there is no information about convergence, because there is no 

adaptive solution to converge with.

Choose the time steps appropriately for the physical time-constants of the 

simulation (about 20 timesteps per cycle).
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Solution Setup (Continued)
The second tab of the Solution Setup contains information about Saving Fields.

Define the sweep (Type, Start, Stop, StepType, Start, Stop, StepType, Start, Stop, StepType, Start, Stop, Step) in the left panel.

Select Add to List >>Add to List >>Add to List >>Add to List >> to place this sweep definition in the Sweep List (the Sweep 

List is displayed in the right panel).

Edit any entries in the Sweep List to adjust saved fields times.

The times that are included in this list will have a full field solution available for 

post-processing.  All other time-steps that are solved will not keep their field 

solutions after solving and moving on to the next time step.

The last time step in a simulation will retain its fields automatically.
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Solution Setup (Continued)
The third tab of the Solution Setup contains Advanced options.

Control Programs Control Programs Control Programs Control Programs are used to dynamically adjust parameters and control the 
simulation – information can be found in the Maxwell Help.

Permeability OptionPermeability OptionPermeability OptionPermeability Option allows the nonlinear B-H operating points either to be 

calculated by the solver from the Nonlinear BNonlinear BNonlinear BNonlinear B----H curveH curveH curveH curve or to use frozen 

permeabilities From LinkFrom LinkFrom LinkFrom Link – the linked solution must have the exact same 

geometry as the current simulation (Nonlinear B-H curve is the default).

Magnetization OptionMagnetization OptionMagnetization OptionMagnetization Option allows the permanent magnetization to be determined from 

the Nonlinear BNonlinear BNonlinear BNonlinear B----H curveH curveH curveH curve or to use demagnetized values From LinkFrom LinkFrom LinkFrom Link - where the 

linked solution selected Compute demagnetized operating pointsCompute demagnetized operating pointsCompute demagnetized operating pointsCompute demagnetized operating points - the linked 

solution must have the exact same geometry (Nonlinear B-H curve is the default).

Import MeshImport MeshImport MeshImport Mesh allows the initial mesh to be imported from another solution – the 

linked solution must have the exact same geometry as the current simulation.

Setup LinkSetup LinkSetup LinkSetup Link must be defined when selecting From LinkFrom LinkFrom LinkFrom Link or Import MeshImport MeshImport MeshImport Mesh.
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Solution Setup (Continued)
The fourth tab of the Solution Setup contains information about the Solver.

Nonlinear ResidualNonlinear ResidualNonlinear ResidualNonlinear Residual defines how precisely the nonlinear solution must define the 

B-H nonlinear operating points (the default value is 0.005).

Solver TypeSolver TypeSolver TypeSolver Type has options for the DirectDirectDirectDirect or ICCG ICCG ICCG ICCG solvers (Direct is the default).

Output ErrorOutput ErrorOutput ErrorOutput Error will calculate the percent energy error (as described in the Solver 

section).  This provides some measure of convergence of the total field solution 

at each time step.  Remember however, that this does not guarantee that the 

field solution is converged at all points.  Also, the calculation of this quantity 
requires a moderate increase in solution time (because the calculation is 

evaluated at every time step).
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Solution Setup (Continued)
The fifth tab of the Solution Setup contains Output Variable options.

Output VariablesOutput VariablesOutput VariablesOutput Variables are added to the list by selecting AddAddAddAdd then selecting the 
available output variables from the pull down list.

This output variable option requires that you first define an output variable before 

adding it (however, you often need to define the analysis setup before you can 

define an output variable – so do not be disoriented if you need to return to these 

settings after defining the analysis setup).

There are two options for defining the time steps at which these output variables 

are calculated.

The first option is to evaluate the output variables at evenly spaced 

increments of time by using a constant time step.

The second option is to evaluate the output variables every Nth step, where 

N is some integer.  The output variable will then be computed at 0s, and 

then at step N, step 2*N and so on.
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Motion Setup 
Choose Assign BandAssign BandAssign BandAssign Band to specify the band object (Maxwell > Model > Motion Setup Maxwell > Model > Motion Setup Maxwell > Model > Motion Setup Maxwell > Model > Motion Setup 
> Assign Band> Assign Band> Assign Band> Assign Band…………).

The Motion Setup window appears when the band is assigned.

Specify RotationalRotationalRotationalRotational or TranslationalTranslationalTranslationalTranslational

Set the Moving VectorMoving VectorMoving VectorMoving Vector (this vector can be defined along one of the axis of any 
coordinate system – you may need to construct a new coordinate system to 

properly assign the proper direction of motion or rotational axis.

Set PositivePositivePositivePositive or NegativeNegativeNegativeNegative to define the direction with respect to the direction of the 

positive axis of the Moving Vector.

Then define the Initial PositionInitial PositionInitial PositionInitial Position and translational or rotational limits.
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Motion Setup (Continued)
In the Mechanical tab of the motion setup, there are two fundamental options:

Velocity Definition

or

Consider Mechanical Transient

Velocity Definition is useful when the velocity is constant or follows a known 

trajectory that can be expressed as a velocity as a function of time.  Use this 

option by de-selecting Consider Mechanical Transient.

Consider Mechanical Transient is useful for situations when the velocity varies 

dynamically or is unknown.  Requires the following inputs:

Initial VelocityInitial VelocityInitial VelocityInitial Velocity or Initial Angular VelocityInitial Angular VelocityInitial Angular VelocityInitial Angular Velocity

MassMassMassMass or Moment of InertiaMoment of InertiaMoment of InertiaMoment of Inertia

DampingDampingDampingDamping

Load ForceLoad ForceLoad ForceLoad Force
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Motion Setup - Suggestions
Read the Maxwell Help note called Meshing Aspects for 3D Transient 
Applications With Motion

When performing translational or non-cylindrical rotational motion, always include 
a vacuum container object within the band that contains all the moving parts.  

This container object should be spaced slightly away from all the objects that it 

contains and should provide clearance when the objects and container move 

within the band.  This container object is necessary for both meshing purposes 

with multiple objects and to produce a better force calculation surface.  A vacuum 
container object is often useful in cylindrical motion too, but not necessary due to 

meshing considerations.  The objects within the vacuum container are assumed 

to move as one rigid body (all moving objects are assumed to move as one rigid 

body by definition of the transient motion solution).

When conceptualizing translational or non-cylindrical rotational motion, 

remember that the moving parts within the vacuum container move as one solid 

body and the remeshing occurs between the surface of the band object and the 

moving objects (generally a container object).

When conceptualizing cylindrical rotational motion, remember that the band 

object and all moving parts rotate without remeshing between.

The conceptual difference between the two is that the band is more solid in the 

cylindrical case (in that it does not change position with respect to the moving 

parts), and the band is more fluid in the translational and non-cylindrical case (in 

that the moving parts change position with respect to the band).

In the translational and non-cylindrical cases, the mesh the is created within the 

band is created so that the edge length is not larger than the average edge length 

for the elements on the surface of the band and the moving parts.  If you wish to 

better define the mesh within the band, you should apply a length-based mesh 

operation on the surfaces of the band and moving parts (simply on the surface of 
the vacuum container if used).



2.3-17

2.3
Transient Analysis

Ansoft Maxwell 3D Field Simulator v11 User’s Guide 

Transient Solution Process
Unlike pre-processing, the solution process is very automated.  Once the 

problem has been defined properly, Maxwell will take over and step through 

several stages of the solution process.  To start the solution process, right-click 

on Analysis in the Maxwell Project Tree and select Analyze.

Initial Setup

Conduction Solution

Nonlinear Convergence

(Changing permeability)

Adjust for Motion

Force/Torque Calculation

Field Solution (concurrent with 
external circuit solution)

Next Time Step

Make Initial Mesh
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Electrostatic Analysis
Electrostatic Analysis is performed by choosing the Electric solution type and 

selecting the Electrostatic option.

Applications that use Electrostatic Analysis can be capacitors, high voltage lines, 
breakdown voltage calculations and many others.

Overview
The electrostatic solver computes static (DC) electric fields.

All objects are stationary.

The source of the static magnetic field can be:

Applied potentials.

Charge distributions.

The quantity solved is the electric scalar potential (ø).

Electric Field (E) and Electric Flux Density (D) are automatically calculated from 

the scalar potential (ø).

Derived quantities such as forces, torques, energy, and capacitances may be 
calculated from these basic field quantities.

Material permittivities and conductivities can be anisotropic.

All fields inside conductors are assumed to be perfect and equipotential in an 

electrostatic equilibrium (no current flow), therefore Joule losses are zero 

everywhere.

Conductivity is irrelevant except to define conductors from insulators.

Can be coupled with a DC conduction simulation, where the electric potential 

from the DC conduction solution is used as a voltage boundary condition for the 
electric field solution in the insulators in an electrostatic simulation.
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Setup
The options in the project tree for an electrostatic simulation control all the 

simulation setup parameters.

Notice that right-clicking on any of the options will open a menu with 

important options for each step of the simulation setup.

The Model definition refers to the geometry

and material definition.

Boundaries and Excitations refer to the 

specific boundaries and excitations available 
in an electrostatic simulation.

Parameters are values that the solver will

automatically calculate after finding the field

solution.

Mesh Operations are discussed in a separate

section.

Analysis defines the solution setup.

Optimetrics defines any automatic variational

analyses.

Results and Field overlays are discussed in a

separate section.

These options are displayed in an order that can be followed in creating a new 
Electrostatic simulation.  This is a general purpose order that goes linearly 

through simulation setup, analysis, and post-processing.  

However, in some cases it is acceptable to work out of the defined order.  This is 
particularly true when defining results, field overlays, or calculated quantities.  It 

is important to think of results when defining the problem setup so that the 

desired quantities may be obtained in a sufficient manner.  Notice, however, that 

the field calculator is not available until a solution setup is defined.
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Electrostatic Material Definition
In an Electrostatic simulation, the following parameters may be defined for a 

material:

Relative PermittivityRelative PermittivityRelative PermittivityRelative Permittivity (can be Anisotropic or Simple)

Relative permittivity determines the electric field solution in the 
insulators.

Bulk ConductivityBulk ConductivityBulk ConductivityBulk Conductivity (can be Anisotropic or Simple)

Bulk Conductivity defines whether an object is a conductor (treated 

as a perfect conductor in the Electrostatic solver) or an insulator.  

This separation is determined by the insulator/conductor material 
threshold setting.
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Electrostatic Boundary Conditions
DefaultDefaultDefaultDefault – The default boundary conditions for the Electrostatic solver are:

NaturalNaturalNaturalNatural boundaries on the interface between objects.

- This means that the normal component of the D Field at the boundary 

changes by the amount of surface charge density on the boundary.

NeumannNeumannNeumannNeumann boundaries on the outer boundaries.

- This means that the E Field is tangential to the boundary and flux cannot 

cross it.

SymmetrySymmetrySymmetrySymmetry – There are two Electric symmetries – even symmetry (flux tangential) 
and odd symmetry (flux normal).  Even symmetry defines E to be tangential to 

the boundary (this is equivalent to the default boundary condition on the outer 

boundary).  Odd symmetry defines E to be normal to the boundary. Remember 

that geometric symmetry may not mean electric symmetry in all cases.  

Symmetry boundaries enable you to model only part of a structure, which 
reduces the size or complexity of your design, thereby shortening the solution 

time. Other considerations for a Symmetry boundary condition:

A plane of symmetry must be exposed to the background.

A plane of symmetry must not cut through an object drawn in the 3D 
Modeler window.

A plane of symmetry must be defined on a planar surface.

Only three orthogonal symmetry planes can be defined in a problem

Master/SlaveMaster/SlaveMaster/SlaveMaster/Slave – This boundary condition is also known as a matching boundary 

condition because it matches the electric field at the slave boundary to the field at 

the master boundary.  The geometry must be identical on each face (the mesh 

needs to be identical, but the solver takes care of this requirement for matched 

geometries) and the faces need to be planar.  It is required to define a U-V 
coordinate system along each face to properly map the matched boundary as 

desired.  Master and Slave boundaries enable you to model only one period of a 

periodic structure, which will reduce the size of a design.  Example applications 

are periodic rotational machines or infinite arrays.
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Electrostatic Excitations
Typical sources for electrostatic problems are net charges (assumed to have a 

uniform distribution) applied to perfect insulator model objects or on surfaces that 

cannot touch conductors and voltages (electric potential applied to perfect 

conductor model objects or on surfaces, also called a Dirichlet boundary 

condition). Additionally, a floating boundary condition can be applied to perfect 
conductors (surrounded by insulators) or to surfaces surrounded by perfect 

insulators.

Voltage Excitations Voltage Excitations Voltage Excitations Voltage Excitations –––– surface or object is at a constant, known potential – E field is 
normal to the boundary.

ChargeChargeChargeCharge – The total charge on a surface or object (either a conductor or dielectric).

FloatingFloatingFloatingFloating – used to model conductors at unknown potentials

Volume Charge DensityVolume Charge DensityVolume Charge DensityVolume Charge Density – The charge density in an object.
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Parameters
There are three parameters that can be

automatically calculated in an 

Electrostatic simulation – ForceForceForceForce, 

TorqueTorqueTorqueTorque, and Capacitance MatrixMatrixMatrixMatrix.

All three quantities are computed 

directly from the electric field solution.

Force and torque can be calculated with
two different methods - Virtual or Lorentz

(Lorentz cannot be used on magnetic 

materials).

The results of any parameters can be found by selecting Maxwell > Results > Maxwell > Results > Maxwell > Results > Maxwell > Results > 
Solution DataSolution DataSolution DataSolution Data………… or by clicking on the        icon.

Further results can be obtained manually through the field calculator.

Mesh Operations
Mesh operations are described in detail in the Mesh operations section.

Remember that the Electrostatic solver has an adaptive mesh solution, so 

excessive mesh operations are not usually required.  It can often be worse to 

over-define the mesh than to not define mesh operations at all (it will take longer 

to solve, and it will be more difficult to adapt correctly).



2.4-7

2.4
Electrostatic Analysis

Ansoft Maxwell 3D Field Simulator v11 User’s Guide 

Solution Setup
The solution setup defines the parameters used for solving the simulation.

Add a solution setup by selecting Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution 
SetupSetupSetupSetup………… or click on the       icon.

The following window appears with the General Setup parameters.

You can NameNameNameName the setup, and you can create multiple setups if you desire (by
repeating this procedure).

Maximum Number of PassesMaximum Number of PassesMaximum Number of PassesMaximum Number of Passes defines a limit to the number of adaptively refined 

passes that the solver performs (the default value is 10).

Percent ErrorPercent ErrorPercent ErrorPercent Error is the error goal for both the Error Energy and Delta Energy.

Solve Fields OnlySolve Fields OnlySolve Fields OnlySolve Fields Only ignores any defined parameters if checked.

Solve MatrixSolve MatrixSolve MatrixSolve Matrix has the options of calculating the matrix after the last solved pass or 

calculating the matrix only if the solution converges.

An option is included to display one Force or Torque parameter in the 

Convergence table.
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Solution Setup (Continued)
The second tab of the Solution Setup contains information about Convergence.

Refinement Per PassRefinement Per PassRefinement Per PassRefinement Per Pass defines the number of tetrahedral elements added during 

mesh refinement as a percentage of the previous pass (30% is the default).

Minimum Number of PassesMinimum Number of PassesMinimum Number of PassesMinimum Number of Passes defines the minimum number of adaptive passes 

before the solution stops - if there is a conflict, this value is over-ridden by 

Maximum Number of Passes (the default value is 2).

Minimum Converged PassesMinimum Converged PassesMinimum Converged PassesMinimum Converged Passes defines the minimum number of adaptive passes 

that have been converged (with respect to the Percent error) before the solution 

stops (the default value is 1).

Use Output Variable ConvergenceUse Output Variable ConvergenceUse Output Variable ConvergenceUse Output Variable Convergence is an option to include a defined output 
variable as an additional convergence criterion with a specified maximum percent 

change per pass (an output variable must be defined for this option to be 

available).



2.4-9

2.4
Electrostatic Analysis

Ansoft Maxwell 3D Field Simulator v11 User’s Guide 

Solution Setup (Continued)
The third tab of the Solution Setup contains information about the Solver.

Solver TypeSolver TypeSolver TypeSolver Type has options for the DirectDirectDirectDirect or ICCG ICCG ICCG ICCG solvers (Direct is the default).

Import MeshImport MeshImport MeshImport Mesh allows the initial mesh to be imported from another solution – the 

linked solution must have the exact same geometry as the current simulation.

Setup LinkSetup LinkSetup LinkSetup Link must be defined when selecting Import MeshImport MeshImport MeshImport Mesh.



2.4-10

2.4
Electrostatic Analysis

Ansoft Maxwell 3D Field Simulator v11 User’s Guide 

Electrostatic Solution Process
Unlike pre-processing, the solution process is very automated.  Once the 

problem has been defined properly, Maxwell will take over and step through 

several stages of the solution process.  To start the solution process, right-click 

on Analysis in the Maxwell Project Tree and select Analyze.

Initial Setup

Adaptive Solution

Field Solution

Refine Mesh

Converged or Number of Passes

Stop Field Solution

Calculate Parameters

Solution Convergence ?

Force/Torque Calculation
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DC Conduction Analysis
DC Conduction Analysis is performed by choosing the Electrostatic solution type 

and selecting the DC conduction option.

Applications that use DC Conduction Analysis can be bus bars, power supplies, 
and many others.

Overview
The DC Conduction solver computes static (DC) currents in conductors.

All objects are stationary.

The source of the static magnetic field can be:

Voltages at different ends of solid conductors.

Currents applied on surfaces of conductors.

The quantity solved is the electric scalar potential (ø).

Current density (J) and Electric Field (E) are automatically calculated from the 

electric scalar potential (ø).

Material conductivities can be anisotropic.

All fields outside of the conductors are not calculated and totally decoupled from 

the electric field distribution in the conductors – permittivity is irrelevant in this 

calculation.

There is non-zero Joule loss (ohmic power loss) in the conductors.

Can be coupled with an electrostatic simulation, where the electric potentials 

found in the conductors are used as a voltage boundary condition for the electric 

field solution in the insulators in an electrostatic simulation.



2.5-2

2.5
DC Conduction Analysis

Ansoft Maxwell 3D Field Simulator v11 User’s Guide 

Setup
The options in the project tree for a DC conduction simulation control all the 

simulation setup parameters.

Notice that right-clicking on any of the options will open a menu with 

important options for each step of the simulation setup.

The Model definition refers to the geometry

and material definition.

Boundaries and Excitations refer to the 

specific boundaries and excitations available 
in a DC Conduction simulation.

There are no parameters for a DC conduction 

simulation.

Mesh Operations are discussed in a separate
section.

Analysis defines the solution setup.

Optimetrics defines any automatic variational

analyses.

Results and Field overlays are discussed in a

separate section.

These options are displayed in an order that can be followed in creating a new 

DC Conduction simulation.  This is a general purpose order that goes linearly 
through simulation setup, analysis, and post-processing.  

However, in some cases it is acceptable to work out of the defined order.  This is 

particularly true when defining results, field overlays, or calculated quantities.  It 
is important to think of results when defining the problem setup so that the 

desired quantities may be obtained in a sufficient manner.  Notice, however, that 

the field calculator is not available until a solution setup is defined.
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DC Conduction Material Definition
In a DC Conduction simulation, the following parameters may be defined for a 

material:

Relative PermittivityRelative PermittivityRelative PermittivityRelative Permittivity (can be Anisotropic or Simple)

Relative permittivity does not affect the DC conduction calculation, 
but will be important in insulators if this is coupled with an 

electrostatic simulation.

Bulk ConductivityBulk ConductivityBulk ConductivityBulk Conductivity (can be Anisotropic or Simple)

Bulk Conductivity defines whether an object is a conductor (treated 

as a perfect conductor in the Electrostatic solver) or an insulator.  
This separation is determined by the insulator/conductor material 

threshold setting.
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DC Conduction Boundary Conditions
DefaultDefaultDefaultDefault – The default boundary conditions for the DC Conduction solver are:

NaturalNaturalNaturalNatural boundaries on the interface between objects.

- This means that the normal component of the current density at the 

boundary is continuous.

NeumannNeumannNeumannNeumann boundaries on the outer boundaries.

- This means that the E Field is tangential to the boundary and flux cannot 

cross it (current cannot leave conductors).

InsulatingInsulatingInsulatingInsulating – This boundary defines a thin, perfectly insulating sheet between 
touching conductors.  This is particularly useful to separate distinct conductors 

(defined on surfaces between the objects).

SymmetrySymmetrySymmetrySymmetry – There are two Electric symmetries – even symmetry (flux tangential) 
and odd symmetry (flux normal).  Even symmetry defines E to be tangential to 

the boundary (this is equivalent to the default boundary condition on the outer 

boundary).  Odd symmetry defines E to be normal to the boundary. Remember 

that geometric symmetry may not mean electric symmetry in all cases.  

Symmetry boundaries enable you to model only part of a structure, which 
reduces the size or complexity of your design, thereby shortening the solution 

time. Other considerations for a Symmetry boundary condition:

A plane of symmetry must be exposed to the background.

A plane of symmetry must not cut through an object drawn in the 3D 
Modeler window.

A plane of symmetry must be defined on a planar surface.

Only three orthogonal symmetry planes can be defined in a problem

Master/SlaveMaster/SlaveMaster/SlaveMaster/Slave – This boundary condition is also known as a matching boundary 

condition because it matches the electric field at the slave boundary to the field at 

the master boundary.  The geometry must be identical on each face (the mesh 

needs to be identical, but the solver takes care of this requirement for matched 

geometries) and the faces need to be planar.  It is required to define a U-V 
coordinate system along each face to properly map the matched boundary as 

desired.  Master and Slave boundaries enable you to model only one period of a 

periodic structure, which will reduce the size of a design.  Example applications 

are periodic rotational machines or infinite arrays.
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DC Conduction Excitations
Typical sources for DC current flow problems are currents applied on surfaces of 

conductors and voltages (electric potential applied to surfaces of conductors).  

The direction of the applied current is either “in” or “out”, always normal to the 

respective surfaces.  Multiple conduction paths are allowed.  Each conduction 

path that has a current excitation must also have either a voltage excitation 
applied or a sink to ensure a unique solution.

Voltage Excitations Voltage Excitations Voltage Excitations Voltage Excitations ---- These are used in conjunction with the material conductivity 

to define the current through a solid conductor.  Either multiple Voltage 
excitations can be used to define a voltage difference across two faces of a 

conductor (creating a current) or a Voltage can be defined along with a current 

excitation to define a voltage reference for the electric field solution.

Current ExcitationsCurrent ExcitationsCurrent ExcitationsCurrent Excitations - This excitation can be assigned on any conductor to define 
the total current (amp-turns) through the cross-sectional face of a conductor.  

SinkSinkSinkSink – This excitation is used when only current excitations are defined in a 

conduction path and there is no voltage excitation.  This excitation ensures that 
the total current flowing through the outside surface of a conduction path is 

exactly zero.

Mesh Operations
Mesh operations are described in detail in the Mesh operations section.

Remember that the Magnetostatic solver has an adaptive mesh solution, so 

excessive mesh operations are not usually required.  It can often be worse to 
over-define the mesh than to not define mesh operations at all (it will take longer 

to solve, and it will be more difficult to adapt correctly).
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Solution Setup
The solution setup defines the parameters used for solving the simulation.

Add a solution setup by selecting Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution Maxwell > Analysis Setup > Add Solution 
SetupSetupSetupSetup………… or click on the       icon.

The following window appears with the General Setup parameters.

You can NameNameNameName the setup, and you can create multiple setups if you desire (by
repeating this procedure).

Maximum Number of PassesMaximum Number of PassesMaximum Number of PassesMaximum Number of Passes defines a limit to the number of adaptively refined 

passes that the solver performs (the default value is 10).

Percent ErrorPercent ErrorPercent ErrorPercent Error is the error goal for both the Error Energy and Delta Energy.

Solve Fields OnlySolve Fields OnlySolve Fields OnlySolve Fields Only ignores any defined parameters if checked.

Solve MatrixSolve MatrixSolve MatrixSolve Matrix has the options of calculating the matrix after the last solved pass or 

calculating the matrix only if the solution converges.

An option is included to display one Force or Torque parameter in the 

Convergence table.
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Solution Setup (Continued)
The second tab of the Solution Setup contains information about Convergence.

Refinement Per PassRefinement Per PassRefinement Per PassRefinement Per Pass defines the number of tetrahedral elements added during 

mesh refinement as a percentage of the previous pass (30% is the default).

Minimum Number of PassesMinimum Number of PassesMinimum Number of PassesMinimum Number of Passes defines the minimum number of adaptive passes 

before the solution stops - if there is a conflict, this value is over-ridden by 

Maximum Number of Passes (the default value is 2).

Minimum Converged PassesMinimum Converged PassesMinimum Converged PassesMinimum Converged Passes defines the minimum number of adaptive passes 

that have been converged (with respect to the Percent error) before the solution 

stops (the default value is 1).

Use Output Variable ConvergenceUse Output Variable ConvergenceUse Output Variable ConvergenceUse Output Variable Convergence is an option to include a defined output 
variable as an additional convergence criterion with a specified maximum percent 

change per pass (an output variable must be defined for this option to be 

available).
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Solution Setup (Continued)
The third tab of the Solution Setup contains information about the Solver.

Solver TypeSolver TypeSolver TypeSolver Type has options for the DirectDirectDirectDirect or ICCG ICCG ICCG ICCG solvers (Direct is the default).

Import MeshImport MeshImport MeshImport Mesh allows the initial mesh to be imported from another solution – the 

linked solution must have the exact same geometry as the current simulation.

Setup LinkSetup LinkSetup LinkSetup Link must be defined when selecting Import MeshImport MeshImport MeshImport Mesh.
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DC Conduction Solution Process
Unlike pre-processing, the solution process is very automated.  Once the 

problem has been defined properly, Maxwell will take over and step through 

several stages of the solution process.  To start the solution process, right-click 

on Analysis in the Maxwell Project Tree and select Analyze.

Initial Setup

Adaptive Solution

Field Solution

Refine Mesh

Converged or Number of Passes

Stop Field Solution

Solution Convergence ?
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Electrostatic and DC Conduction Combination
The combination of the DC current flow and electrostatic solution is based on the 

division of the arrangement into conductors and insulators (determined by the 

object’s conductivity and the insulator/conductor material threshold). The 

solution of such problems is performed in two steps: first the DC conduction 

problem in the conductors is computed, then the electrostatic solution is 
calculated using the electric scalar potential of the conductors as a voltage 

boundary condition.

Select the Electrostatic and DC Conduction combination by choosing the 
Electrostatic solution type and selecting both the electrostatic and the DC 

conduction options.

The setup for a ElectroDCConduction simulation is the same as if setting up a 

DC Conduction simulation in the conducting objects, and setting up an 
Electrostatic simulation in the insulators.  All boundary conditions and excitations 

for both setups are available when both options are selected.  It is up to the user 

to set up the simulation appropriately in each domain.
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Mesh Operations
This chapter provides details on meshing in the Ansoft Maxwell v11 software.   It 

discusses the default process of creating a mesh, meshing of curvature, user 

control of meshing, and intermediate methods of manual mesh refinement.  The 

following topics are discussed:

Initial Mesh Process

Adaptive Mesh Process

Mesh Considerations and Impact on Solutions

Applying Mesh Operations

Surface Approximations

Curved Geometry Mesh Adaptation

Model Resolution

Length Based Mesh Operations

Skin Depth Based Mesh Operations

Mesh Reduction Techniques

Dummy Objects

Linking Mesh

Transient

Non-transient

Mesh failures and suggestions
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Initial Mesh Process
When you first analyze a problem, there must be an initial mesh in place to 

perform a field calculation.  The initial mesh is automatically constructed without 

any instructions from the user (besides for the geometry definition) when the 

analysis is first performed.  The initial mesh is only constructed if no current mesh 

exists – if a current mesh exists Maxwell will solve without creating a new initial 
mesh.  The automatic mesh process goes something like the following:

Check model for errors and 

intersections.

Create basic mesh point information from 

geometry vertices and model resolution data.

Smooth mesh.

Match up surface mesh between 

objects and insert points.

Create mesh on the surface of curved 

objects using surface approximations 

(this is called surface triangulation).

Pass mesh information to the 

field solver.

Click Analyze

Length and Skin Based Refinements.
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Adaptive Mesh Process
The adaptive mesh process takes numerous factors into consideration when 

deciding where to refine the mesh at each pass.  There are geometry factors, 

field solution factors, and everything is based on the percent refinement number 

defined in the analysis setup dialog.

If the percent refinement is set to 30%, and there are 1000 elements at pass 1, 

then 300 points will be added for pass 2.  This increase may not be exactly 30% 

due to smoothing and other factors that will adjust the actual percent refinement.

The refined mesh points are calculated by the field solver and placed at points 

where there are strong fields, large errors, large field gradients, or areas that 

generally have a large impact on the field solution.  This list of refined points is 

then passed on to the meshing procedure which places the points and creates an 

optimal refined mesh for the next adaptive pass.

Solver creates a list of points to 

add for next pass.

Next adaptive pass.

Smooth mesh.

Add points determined from 

previous adaptive pass.

Pass mesh information to the 

field solver

Field solver finds field solution.
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Mesh Considerations and Impact on Solutions
The mesh is important for two separate, yet related reasons – first, the mesh is 

used to directly determine the numerical field solution, second, the mesh is used 
to produce all secondary results such as volume integrations or other field 

calculations.

There is a trade-off among the size of the mesh, the desired level of accuracy 
and the amount of available computing resources.

The accuracy of the solution depends on the size of each of the individual 

elements (tetrahedra).  Generally speaking, solutions based on meshes using 
thousands of elements are more accurate than solutions based on coarse 

meshes using relatively few elements.  To generate a precise description of a 

field quantity, each element must occupy a region that is small enough for the 

field to be adequately interpolated from the nodal values.

However, generating a field solution involves inverting a matrix with 

approximately as many elements as there are tetrahedra nodes.  For meshes 

with a  large number of elements, such an inversion requires a significant amount 

of computing power and memory.  Therefore, it is desirable to use a mesh fine 

enough to obtain an accurate field solution but not so fine that it overwhelms the 
available computer memory and processing power.

Generally, uniform mesh elements with equilateral triangular faces are best 

suited for second order interpolated field solutions.  However, these triangles are 
not easy to produce with complex geometries.  The important thing to remember 

is not to over-define the mesh in any region (this is especially true for non-

transient simulations).  It is often necessary to define the mesh on specific 

surfaces or volumes for further calculations, however there are efficient and 

inefficient methods to achieve good results.

Inefficient meshes pick up all the details of every curve and joint, even in 

unimportant areas for the field solution.  There are methods that we will discuss 

that can decrease the mesh in areas of low importance and promote overall 
convergence of the field solution.
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The Initial Mesh and Why Mesh Operations are Often Necessary
The initial mesh is created only by taking into account the design’s geometry.  

For example, if only one box is included in the simulation, there will be 5 
elements generated inside the box in the initial mesh.  Only the corners of the 

geometry are used to create the initial mesh – this is constructed by an initial 

mesh-maker that only looks at the geometry and knows nothing about the field 

structure (there is no solution yet, so there can be no knowledge of the field 
solution).

It is often the case that the initial mesh is too coarse in the regions of interest to 

produce an efficient, accurate field solution (this is certainly true in transient 

simulations).  Mesh operations are able to define a manual refinement to the 
initial mesh that can improve simulation time and provide enhanced solutions in 

some cases.

It is sometimes the case that the initial mesh is overly defined in some places, 
due to joints in the geometry or difficult to mesh areas.  Mesh operations can 

better define the initial mesh in the entire solution region so that the mesh is most 

efficient and improvements are possible for both simulation time and solution 

accuracy.  This can even allow the simulation of geometries that would be 

impossible without mesh operations.

Sometimes the initial mesh has difficulties that can be fixed by assigning mesh 

operations.  This means that problems that are not solvable with the default initial 

mesh can sometimes be solved with the addition of a few mesh operations (or 
with mesh considerations in mind during geometry creation).
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Applying Mesh Operations
If you want to refine the mesh on a face or volume you do not necessarily have to 

generate a solution.  Do either of the following after defining mesh operations to 

apply mesh operations:

Select Maxwell > Analysis Setup > Apply Mesh OperationsMaxwell > Analysis Setup > Apply Mesh OperationsMaxwell > Analysis Setup > Apply Mesh OperationsMaxwell > Analysis Setup > Apply Mesh Operations, or right-click on 
the setup name in the project tree and choose Apply Mesh Operations.Apply Mesh Operations.Apply Mesh Operations.Apply Mesh Operations.

Analyze the design – the mesh operations will take effect when creating the 

mesh for the current adaptive pass.

For non-transient simulations, the following behaviors can be expected when 
applying mesh operations using either of the above methods:

If a current mesh has been generated, Maxwell will refine it using the 

defined mesh operations.

If a current mesh has not been generated, Maxwell will apply the mesh 
operations to the initial mesh. 

If an initial mesh has not been generated, Maxwell will generate it and 

apply the mesh operations to the initial mesh. 

For transient simulations, the mesh must be the same from one time step to the 

next, therefore, adjusting mesh operations of a transient simulation will force the 

simulation to start from time zero.

Select Maxwell > Analysis Setup > Revert to Initial Mesh Maxwell > Analysis Setup > Revert to Initial Mesh Maxwell > Analysis Setup > Revert to Initial Mesh Maxwell > Analysis Setup > Revert to Initial Mesh to clear the mesh 
information (as well as any solution information) and revert to the initial mesh.  

This can also be accessed by right-clicking on the setup name and choosing 

Revert to Initial MeshRevert to Initial MeshRevert to Initial MeshRevert to Initial Mesh.
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Applying Mesh Operations (Continued)
Note the following:

If the defined mesh operations have been applied to the selected face or 

object, the current mesh will not be altered.

Define a new mesh operation rather than modify an existing mesh 
operation. Maxwell will not re-apply a modified mesh operation. 

Applying mesh operations without solving enables you to experiment with 

mesh refinement in specific problem regions without losing design 

solutions. You cannot undo the applied mesh operations, but you can 

discard them by closing the project without saving them.

Model Resolutions adjust the effective geometry used for the initial mesh 

(and the mesh maker used in solving the problem), so, applying a model 

resolution will invalidate any solutions and revert to the initial mesh.

Surface approximations only work on the initial mesh.  If a surface 
approximation is applied with an existing current mesh, it will not take effect 

until the mesh has been cleared.

You can look at the mesh by selecting Maxwell > Fields > Plot MeshMaxwell > Fields > Plot MeshMaxwell > Fields > Plot MeshMaxwell > Fields > Plot Mesh………… or by right-
clicking on Field OverlaysField OverlaysField OverlaysField Overlays in the project tree and choosing Plot MeshPlot MeshPlot MeshPlot Mesh.  A setup 
must be created to define the plot.  An object or surface must be selected to 

create the mesh plot.  Read the section on Data Reporting to find out more about 

field plotting on 3D geometries.

You can view mesh statistics by right-clicking on the setup name and choosing 

Mesh StatisticsMesh StatisticsMesh StatisticsMesh Statistics (except for Transient simulations), or by going to the Solution

Data or Analysis Profile and choosing the Mesh Statistics tab.  This mesh 

statistic information represents information about element length (the length of 

the sides of each element), the tet volume (the volume of the tetrahedral mesh 
elements), and the total number of elements in each object.
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Surface Approximations
Object surfaces in Maxwell may be planar, cylindrical or conical, toroidal, 

spherical or splines.  The original model surfaces are called true surfaces.  To 
create a finite element mesh, Maxwell first divides all true surfaces into triangles.  
These triangulated surfaces are called faceted surfaces because a series of 

straight line segments represents each curved or planar surface.

For planar surfaces, the triangles lie exactly on the model faces; there is no 

difference in the location or the normal of the true surface and the meshed 

surface.  When an object’s surface is non-planar, the faceted triangle faces lie a 
small distance from the object’s true surface.  This distance is called the surface 
deviation, and it is measured in the model’s units.  The surface deviation is 
greater near the triangle centers and less near the triangle vertices.

The normal of a curved surface is different depending on its location, but it is 
constant for each triangle.  (In this context, “normal” is defined as a line 

perpendicular to the surface.)  The angular difference between the normal of the 

curved surface and the corresponding mesh surface is called the normal 
deviation and is measured in degrees (15deg is the default).

The aspect ratio of triangles used in planar surfaces is based on the ratio of 
circumscribed radius to the in radius of the triangle.  It is unity for an equilateral 

triangle and approaches infinity as the triangle becomes thinner (see the aspect 

ratio comments after the usage suggestions for a detailed explanation).

You can modify the surface deviation, the maximum permitted normal deviation, 

and the maximum aspect ratio of triangles settings on one or more faces at a 
time in the Surface ApproximationSurface ApproximationSurface ApproximationSurface Approximation dialog box.  (Click Maxwell > Mesh Operations Maxwell > Mesh Operations Maxwell > Mesh Operations Maxwell > Mesh Operations 
> Assign > Surface Approximation> Assign > Surface Approximation> Assign > Surface Approximation> Assign > Surface Approximation.)

The surface approximation settings are applied to the initial mesh.

Below is a diagram that illustrates the surface deviation, “dddd”, and the normal 
deviation, “θθθθ”.
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Surface Approximations (Continued)
Since refining curved surfaces is not always enough to produce an efficient 

solution, users can control the fidelity to which the initial mesh faceting conforms 

to geometric curvature by assigning Surface Approximations to appropriate 
objects and/or object faces

Mesh Operations can be assigned from the MaxwellMaxwellMaxwellMaxwell menu, from the Project TreeProject TreeProject TreeProject Tree, 

or from the geometry interface’s context-sensitive menu.

The Surface Approximation options are shown below right.  Definitions follow:

Surface Deviation is the maximum spacing,
in drawing units, that the tetrahedral surfaces

may be from the true-curved geometry’s
surface.

Normal Deviation is the maximum angular
difference, in degrees, that a tetrahedral

face’s normal can have from the surface 
normal for the true geometry which it is 

meant to represent.

Aspect Ratio refers to the maximum allowed
aspect ratio of all faces of all tetrahedra of

the selected object or face.  This setting 
influences mesh quality rather than actual

meshed volume or surface locations.
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Surface Approximations - Usage Suggestions
Do not Do not Do not Do not overspecifyoverspecifyoverspecifyoverspecify....

It is always easier to ‘add’ than subtract mesh, by running more adaptive 

passes or by adding supplemental mesh instructions

Too stringent a setting (e.g. Normal Deviation of 1 degree) can result in 
poor mesh qualities due to aspect ratios, poor mesh gradients to

surrounding objects, etc.

Use Aspect Ratio settings along with Normal or Surface Deviation settings

For cylindrical type objects where curved and planar faces meet, the 

normal and surface deviation settings apply to the curved faces only.  
Setting an aspect ratio limit as well (e.g. 4:1) will force a few additional 

triangles on the planar faces and help preserve a cleaner overall mesh

Consider using Polyhedrons or Polygons instead if using to ‘reduce’ mesh

If your design has many curved objects which you want only very coarsely 
meshed (e.g. individual current-carrying wires with no eddy or proximity 

effects, for which 15 degree default normal deviation is unnecessary), and 

the geometry is not imported, consider drawing the objects as hexagonal or 

even square solids instead.

Surface approximations can be applied to either entire objects or faces (in groups 
or individually) or sheets.  The surface approximations take effect during the 

surface meshing, so it does not matter if an object is selected whole, or if all 

faces of an object are selected to apply these operations – either way, the volume 

of the object will be meshed after the surface approximation is considered.

Surface Approximations – Aspect ratio comments
There is a different definition of aspect ratio on curved and planar surfaces, but in 

either case, the aspect ratio is defined by the triangles on the selected surfaces.

On curved surfaces, the aspect ratio is essentially defined by the height to 

width ratio of the triangles.  The default minimum aspect ratio is around 1.2 

and will tend to form nearly isosceles right triangles on the faceted faces.  

The default aspect ratio on curved surfaces is 10.

On planar surfaces, the aspect ratio is equal to the circumscribed radius 
over twice the inner radius of each triangle – this produces 1 for an 

equilateral triangle.  (See the diagram at left to see what is meant by 

circumscribed circle and inner circle of a triangle.)  The default minimum 

aspect ratio is around 2.  The default aspect ratio on planar surfaces is 200.

Specifying an aspect ratio of 1 will not produce perfectly equilateral triangles.
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Curved Geometry Mesh Adaptation
The new graphical drawing interface encourages the use of true-curved drawing 

by removing the option to assign a facet count to the construction of primitives 
such as circles, cylinders, spheres, and ellipses.

Faceted primitives are available however as polyhedrons and polyhedral 

solids, if desired.

Initial meshing is constrained by faceting decisions made by the first pass of the 
meshing algorithms.  However, adaptive mesh points can be placed ‘anywhere’

on the true-surface of the curved object(s), as shown in the before and after 

images below. (Initial mesh left, partly adapted in middle, fully adapted at right.)  

Note that regular faceting is not maintained after adaptive mesh alteration.

This example documents a cylindrical, linear magnet oriented in the Z-direction, 

with a 200% padded region.  The pictures correspond to the initial pass, the 10th

pass, and the 18th pass, with total mesh sizes of 401, 4969, and 14135 mesh 
elements for each respective pass.

The increase in mesh size due to the refinement of the cylinder may increase 

model fidelity, but it may also increase the solution time.

Note that if you wish to maintain the initial faceting, you can use faceted 

primitives during geometry creation.
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Model Resolution
In many models (especially imported models), there are small geometric details 

that are present, yet do not affect the field solution to a large extent.

Small features in the geometry can lead to a mesh that is unnecessarily large and 

contains long and thin tetrahedra that make the simulation converge slower.

For these reasons and more, Model resolution allows the initial mesh to generate 

without including all the little details that can slow down simulations and do not 

add to the quality of the solution.

Model resolution improves model convergence and reduces solve times. If in 

previous versions the tetrahedron count got too large, the solver could run out of 
memory. It would be trying to add meshing elements to areas of the model that 

are not important. Now with model resolution, we are able to crank down the 

mesh size in order to actually get convergence before memory becomes an 

issue. 

Model resolution is a length based value that modifies the initial mesh. This 
meshing operation allows the user to specify a minimum edge length of any 

tetrahedron used for the mesh. By specifying a minimum edge length for a 

tetrahedron, the mesher will have to coarsely mesh geometric detail that may not 

be important for the field solution. This saves the solver a tremendous amount of 
solution time since the initial mesh is smaller, and the mesher does not have to 

add mesh elements to areas that are not important for the field solution.

Model resolution can be assigned from the MaxwellMaxwellMaxwellMaxwell menu, from the Project TreeProject TreeProject TreeProject Tree, 

or from the geometry interface’s context-sensitive menu, and is found 
immediately below Surface Approximation in the Mesh Operations list.

The Model Resolution dialog is presented below.  The suggested value for the 

resolution length is determined by the smallest edge length on the selected 
objects.  This may not be the best value to use, but it might be a good place to 

start or, at least, a good reference.
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Model Resolution (Continued)
Model resolution capabilities are an expanded capability of the ACIS engine and 

are incorporated into the new fault tolerant meshing features.  By default, ACIS 

uses 1.0e-6 model units as the smallest possibly resolved length.  Any two

geometry points that are closer than this absolute resolution length (ResAbs) will 

not be resolved by ACIS (so choose the model units appropriately).

By default, if there are difficulties creating an initial mesh, a second initial mesh 

will be attempted with a model resolution automatically applied to all model 

objects with 100 times the absolute resolution length (ResAbs).  If continued 
difficulties are experienced, a third initial mesh will be attempted with an 

automatic model resolution of 1000 times ResAbs on all model objects.  After the 

third attempt a mesh failure is reported (you will be able to see three distinct 

“mesh_init” lines in the analysis profile).

If the user specifies the model resolution length so that the mesh grossly 

misinterprets the model or changes the contacts between the objects, Maxwell 

will detect this and report this as an error (“MRL too large or object_name lost all 
surface triangles”).
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Model Resolution (Continued)
Practical Example

This is part of a complex design that benefited from model resolution. The 

grey outline is the reduced model. The pink lines were the original model 

details that were removed due to the mesh operation. The original model 

had an initial mesh of 184,675 tets. After model resolution, the initial mesh 
was 24,691 tets.



3-15

3
Mesh Operations

Ansoft Maxwell 3D Field Simulator v11 User’s Guide 

Model Resolution – Usage Suggestions
Apply model resolution to one specific object or a group of objects.  Be aware of 

what the size of important details are when assigning a new model resolution to 

an object or group of objects.  Measure various lengths (3D Modeler > Measure3D Modeler > Measure3D Modeler > Measure3D Modeler > Measure) 
to survey some nominal lengths for the specific objects.  Then, when applying the 

model resolution, look at the number suggested in the model resolution 
assignment dialog – this number is the smallest edge found on the selected 

objects.  If this edge is very much smaller than some of the measured and 

expected lengths, apply a model resolution that is larger than the suggested 

value, yet significantly smaller than the expected length (for example, if you have 

an object that is cube-like with 10in sides, yet the smallest length is returned as 
1e-6in, you should apply a model resolution of about 0.1in to the object).

If the mesh fails with a vague error, occasionally, applying a model resolution to a 

complicated object will assist the initial mesh generation.

Model resolution is very useful when dealing with imported geometries.

When dealing with models that have very high aspect ratios due to small 
geometric detail, use a model resolution of 1/10 to 1/20 of the thinnest conductor 

to start with. Then adjust the value accordingly.

It is often good to be conservative with model resolutions as a large model 
resolution can cause mesh errors.  

Model resolution is often most useful when fillets, chamfers, and other small 

features are included at joints and corners – these can often be ignored for 

electromagnetic simulations and are often small enough to use an appropriate 
model resolution.

Always create the initial mesh and look at the surface mesh on objects before 

solving the problem.  If too aggressive of a model resolution is used, then 
important features can be skipped with a model resolution – it is important to 

know that the mesh is appropriate for the simulation.
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Length Based Mesh Operations
Length based mesh operations are perhaps the most basic conceptual mesh 

refinement option.  The assignment of a length based mesh operation limits the 

edge length of all tetrahedral elements inside an object or on an object’s surface.

There are two types of length based mesh operations:

On Selection

Inside Selection

The Length-based On-selection refinement will limit the edge length of all 

triangles formed on the surface of a selected object (or group of objects), or any 

selected faces.

The Length-based Inside-selection refinement will limit the edge length of all 
tetrahedral elements inside the selected object (or group of objects).

The assignment of these two types are similar – simply choose either:

Maxwell > Mesh Operations > Assign > On Selection > Length BasedMaxwell > Mesh Operations > Assign > On Selection > Length BasedMaxwell > Mesh Operations > Assign > On Selection > Length BasedMaxwell > Mesh Operations > Assign > On Selection > Length Based ………… or
Maxwell > Mesh Operations > Assign > Inside Selection > Length BMaxwell > Mesh Operations > Assign > Inside Selection > Length BMaxwell > Mesh Operations > Assign > Inside Selection > Length BMaxwell > Mesh Operations > Assign > Inside Selection > Length Based ased ased ased …………

The same dialog appears for both types of assignment - the only difference is 

whether it affects all edges within an object or all edges on a face (or surface).

The default value for Maximum Length of ElementsMaximum Length of ElementsMaximum Length of ElementsMaximum Length of Elements is 20% of the largest edge-

length of the bounding boxes of each selected face.

For a cube, the default length-based on-selection refinement will produce 

about 7 triangles along an edge for a total of about 100 triangles per face.
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Length Based Mesh Operations (Continued)
There is one other option that is 

provided when assigning a length

based mesh operation that will limit 

the number of elements that are 

added into the simulation with that 
particular mesh refinement.

Restrict the Number of ElementsRestrict the Number of ElementsRestrict the Number of ElementsRestrict the Number of Elements is

a hard limit and no more than the 
specified number of elements will be

added to the simulation for the 

particular mesh operation than are 

specified here (unless the box is 

un-checked).

For example: if the restriction to the 

length of elements requires 3000 

additional elements, yet the number 
of elements is restricted to 1000, then only 1000 elements will be added, and the 

elements will not meet the Length of Elements requirement (they will be larger 

than specified).

This second restriction brings another possible method of adding elements to 
objects without regard to the dimension of the object – you may uncheck the 

Length of Elements restriction and enter a value for the Number of Elements 

restriction, thereby adding a defined number of elements to the simulation.

This second method of adding elements is good and bad, because it allows 

control over the number of elements that are inserted into the defined objects for 

the particular mesh operation, however, it does not necessarily need to meet any 

length requirements (so the elements could still be too large).
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Length Based Mesh Operations - Example
This example uses a cube inside a Region with 100% padding.  An initial mesh 

was created for four different cases of applying length-based mesh operations.

First, a default initial mesh was created without defining any mesh operations.

Second, an initial mesh was created by defining a length-based mesh operation 
on the surface of the box at the default maximum length setting (20% edge 

length).

Third, an initial mesh was created by defining a length-based mesh operation 

inside the box at the default maximum length setting (20% edge length).

Fourth, an initial mesh was created with a length-based mesh operation defined 
both on and inside the box at the default maximum length settings – 2 mesh 

operations were used.

Default Initial mesh

42 elements

Initial mesh with Length-Based 

On-Selection set to 20%

6467 elements

Initial mesh with Length-Based 

Inside-Selection set to 20%
6698 elements

Initial mesh with Length-Based Inside 
& On Selection set to 20%

9042 elements



3-19

3
Mesh Operations

Ansoft Maxwell 3D Field Simulator v11 User’s Guide 

Skin Depth Based Mesh Operations
Skin depth based mesh operations 

are similar to On-selection length-

based mesh operations.  These 

operations are defined by both the 

triangles on the surface and a 
seeding inside the selected faces.

This refinement method creates 

layers of mesh within the 
selected surfaces of objects – this 

is useful for modeling induced 

currents near the surface of a 

conducting object.

Skin Depth Skin Depth Skin Depth Skin Depth defines the classical 

skin depth value (discussed on 

the next page).

Number of LayersNumber of LayersNumber of LayersNumber of Layers defines the 

number of layers of points that 

are placed at distances according

to the skin depth value.

The Surface Triangle LengthSurface Triangle LengthSurface Triangle LengthSurface Triangle Length is equivalent to the surface length restriction for 

length-based refinement.

The Number of ElementsNumber of ElementsNumber of ElementsNumber of Elements is equivalent to the surface element restriction for 
length-based refinement.  The total number of elements added may exceed this 

number by a factor of the Number of Layers.
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Skin Depth Based Mesh Operations (Continued)
Instead of inserting a value straight into the skin depth box you can use the 

automatic skin depth calculator.  Simply fill in the relative permeability and 

conductivity of the material, and the measurement frequency to calculate and 

insert the skin depth in the skin depth box.

The skin depth of an object is calculated as:

Currents are concentrated near the surface of the conductor, decaying rapidly 

past the skin depth. As the formula above indicates, the skin depth gets smaller 

as the frequency increases. 

The skin depth based mesh operation is most important in eddy current and 

transient simulations where eddy currents and proximity effects are important to 

the solution of the simulation.
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Mesh Reduction Techniques
Because the mesh size affects the simulation time, it is often desired to decrease 

the total number of elements in a simulation to also decrease total simulation 

time.  This can be done either at the expense of accuracy or not depending on 

the efficiency of the mesh construction.  There are several ways to reduce the 

mesh size – here are a few examples.

1. Mitigate large aspect ratios with intelligent geometry construction.

If you have a thin conductor that is far from other objects, this conductor 

should not be drawn with curved surfaces.  Draw a square or regular 
polygon and sweep the square along the path of the conductor.  This will 

limit the number of triangles necessary in a large aspect ratio object and 

will decrease the total number of mesh elements in the simulation.

2. Add a vacuum container object (dummy object) around all objects in simulation.  

This can be a good method to limit the aspect ratios of triangles in the 

region.  The region needs to be defined a certain distance away from the 

components (due to fringing fields) – so this vacuum container can assist 

the mesh construction and reduce aspect ratios in the region near to the 
structure.

3. Use a model resolution when it will reduce the size of the mesh but not affect the 

solution of the simulation.

Look at the Model Resolution usage suggestions for more information.

4. Use faceted objects instead of curved surfaces when the surface is not in an area 

of high fields.

Faceted objects are easier to mesh and do not add more surface elements 

in the same manner as curved objects.  This can reduce the mesh 

significantly in many cases. Curved surfaces may provide a more true 

representation of objects, especially important in areas with large fields.  

However, using faceted surfaces even with large fields may be appropriate 
and may reduce the mesh in many cases.

5. Add small mesh operations on conductors and inside magnetic materials.

These will intelligently assist the initial mesh formation, so that less 
adaptive passes are necessary.
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Dummy Objects
Placing an object of the same material inside another object does not affect the 

field solution for the field solver.  However, this additional object defines another 

set of surfaces on which the initial mesh will form.  This object can also have 

additional mesh operations defined on it.  For these reasons and more, adding 

additional objects may assist the mesh formation process, and, moreover, 
increase the amount of control with which you can define the initial mesh.  These 

objects are called dummy or virtual objects.

Some example places to use dummy objects are the following:

In the gap of a magnetic core.

As a container object for subgroups of objects (such as the inner rotor of an 

rotational machine).

As a container object for all objects.

Around a sensor.

Around a surface that will be integrated on.

Around a line that will be used for plotting or calculations.

These dummy object examples serve different purposes – the first three 

examples in the above list are intended to improve the general convergence of 

the solution, while the last three examples are intended to improve the post-

processing results due to the local mesh in the vicinity of the measurement.

When placing dummy objects, use simple objects (such as rectangles, or regular 

polyhedrons) when possible.  The size of the dummy objects should be 

comparable to the objects around it.  The placement is sometimes best to be 

placed slightly away from model objects (such as a container object for a 
rotational machine – which should have its radius in the middle of the gap, or 

equally spaced in the gap with the band object) where the placement creates an 

extra layer of mesh elements that allow for better calculation of changing fields.  

Other times the placement is best when the dummy object touches the model 

objects (such as in the gap of a magnetic core) where the dummy object helps to 
both reduce the aspect ratio in the surroundings and to provide an object to apply 

mesh operations if desired.



3-23

3
Mesh Operations

Ansoft Maxwell 3D Field Simulator v11 User’s Guide 

Linking Mesh - Transient
Every solution type has a mesh linking capability.  It is sometimes necessary to 

have a simulation linked (when using demagnetization options, or otherwise).  

However, it can be beneficial for mesh purposes to link a mesh from another 

simulation.  This is nowhere as powerful as in a transient simulation. 

Because a transient simulation does not adaptively refine its mesh, the mesh that 

it uses is constrained the initial mesh.  Mesh operations can assist in manually 

refining the mesh, but this can be insufficient sometimes.  What is provided with 

mesh linking, is the power of an adaptively refined mesh used in a transient 
simulation.

A transient simulation can be linked to any other simulation with the exact same 
geometry.  This means that a magnetostatic or eddy current simulation can be 
adaptively solved to any accuracy, then the design can be copied and converted 
to a transient simulation that uses the same adaptively refined mesh.

In the transient simulation Analysis Setup, simply check Import MeshImport MeshImport MeshImport Mesh.  When this 

box is initially checked on, a dialog appears that sets up the mesh link.  

Either select This ProjectThis ProjectThis ProjectThis Project or browse to the desired project file.  Then choose the 
design name within the selected project and the desired setup name within the 

design.  Adjust any parameters if necessary and then select OKOKOKOK.  The mesh in 

the transient simulation will now be identical to the mesh in the selected 

project/design/setup.
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Linking Mesh – Non-Transient
There are several important reasons why mesh linking capabilities are important 

in non-transient simulations.  One example is if DC power flow calculations are 

performed, both an electrostatic and a magnetostatic solution are required, and 

the mesh must be identical to perform the necessary calculations (see the Field 

Calculator topic for an example).  Another example is if the exact same mesh is 
required in a parametric sweep (especially important with distributed analysis).

Note that if mesh operations are included in a linking simulation, the model 

resolution and surface approximations are ignored – however, the length-based 
and skin-depth based resolutions are performed.  If identical meshes are desired, 

delete mesh operations from the linking simulation.

You cannot link two analysis setups within the same design.

Any simulation can be linked to any other simulation with the exact same 
geometry (regardless of solution type).

In the Analysis Setup, simply check Import MeshImport MeshImport MeshImport Mesh.  When this box is initially 
checked on, a dialog appears that sets up the mesh link.  In the dialog, either 

select This ProjectThis ProjectThis ProjectThis Project or browse to the desired project file.  Then choose the design 

name within the selected project and the desired setup name within the design.  

Adjust any parameters if necessary and then select OKOKOKOK.  The mesh in the linking 
simulation will now be identical to the mesh in the selected project/design/setup.

To guarantee identical meshes in a parametric sweep (with no geometry 

variations) do the following:

1. Create a nominal design and solve it.

2. Copy the design and delete mesh operations.

3. Set up the mesh link in the copied design.

4. Create a parametric sweep in the linking design.

This will guarantee that every row of the parametric sweep (assuming no 
geometry variations) will use an identical mesh.

To re-initialize the linked data, select Maxwell > Analysis Setup > Clear Linked Maxwell > Analysis Setup > Clear Linked Maxwell > Analysis Setup > Clear Linked Maxwell > Analysis Setup > Clear Linked 
DataDataDataData or right-click on AnalysisAnalysisAnalysisAnalysis and choose Clear Linked DataClear Linked DataClear Linked DataClear Linked Data.
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Mesh Failures and Suggestions
There are several different points at which the mesh can fail even if the design 

passes all model verifications (no ACIS errors, no non-manifold objects, no 

partial intersections).

If an ACIS error or other geometry error occurs, please see the section on 

geometry import/healing.

Information about a mesh failure will appear in 3D Modeler > Model Analysis > 3D Modeler > Model Analysis > 3D Modeler > Model Analysis > 3D Modeler > Model Analysis > 
Show Analysis Dialog > Last Simulation MeshShow Analysis Dialog > Last Simulation MeshShow Analysis Dialog > Last Simulation MeshShow Analysis Dialog > Last Simulation Mesh………….

Generally, the mesh will fail at the point where it tries to match the surface mesh 

between objects.  The error for this failure will state “Volume Meshing Failed –
Stitching flag <#> failure mode <#>”.  This is often the case if surfaces are not 
perfectly coincident – if there is a small gap between two objects, the mesh will 

have difficulties filling the gap yet retaining a reasonable aspect ratio and form.

Another semi-frequent mesh error is “Incompatible Faceting”.  This error is 
almost exclusively related to coincident true surfaces.  There is some information 
on coincident true surfaces in the geometry import/healing section.

You can determine which part of the model is causing problems for the mesh by 

making an object non-model (double-click on the object to bring up the Properties 
dialog – then deselect the ModelModelModelModel check-box).  If it meshes, then that object is the 

problem.

Can you move the faces of the object or move the object so that it is not 
coincident (or is fully coincident)?  Try to change the geometry a little bit without 

changing the solution.
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Mesh Failures and Suggestions (Continued)

Look in 3D Modeler / Model Analysis > Show Analysis Dialog > Last Simulation Mesh.

Follow up on what the dialog says

Consider eliminating tiny details through healing

Consider aligning faces through healing

Determine which object or part of object is the trouble maker

Try miscellaneous modifications

Redraw as much as is needed to get the geometry to mesh

Vary Model Resolution and Surface Deviation



Ansoft Maxwell 3D Field Simulator  v11 User’s Guide 

3.1
Geometry Import/Healing

3.1-1

Importing a geometry into the 3D modeler and Healing of 

geometries
Geometries can be imported from many sources in numerous formats.  The 

importing of geometry allows complicated structures from CAD type tools to 
be used within an electromagnetic simulation.  Several points must be kept 

in mind when importing geometries, as important details in a CAD tool may 

not be important to (or may even be detrimental to) an electromagnetic 

simulation.  However, with some general guidelines and knowledge of what 

to look for, most geometries can be imported from many of the standard 
modeling tools.  

When geometries are imported, conversions may be necessary to allow the 

file format to be read by the 3D Modeler.  There may be very small errors in 

this conversion process which require healing.  Also, the geometry of your 
model will determine the meshing characteristics of the simulation, so proper 

consideration for meshing should be given when creating, importing, and 

healing objects.  Several different methods of healing imported objects and 

objects created in the 3D Modeler exist and will be discussed.
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Ansoft Maxwell Design Environment
The following features of the Ansoft Maxwell Design Environment are used to 

create the models covered in this topic

Edit

Duplicate: Around AxisAround AxisAround AxisAround Axis

3D Solid Modeling

ImportImportImportImport

Purge HistoryPurge HistoryPurge HistoryPurge History

Model Analysis: Analyze ObjectsAnalyze ObjectsAnalyze ObjectsAnalyze Objects

HealHealHealHeal

Align FacesAlign FacesAlign FacesAlign Faces

Surface Operations:  Move Faces Move Faces Move Faces Move Faces 

Boolean Operations: UniteUniteUniteUnite

SubtractSubtractSubtractSubtract

IntersectIntersectIntersectIntersect

Separate BodiesSeparate BodiesSeparate BodiesSeparate Bodies

Mesh Operations

Surface ApproximationSurface ApproximationSurface ApproximationSurface Approximation

Model ResolutionModel ResolutionModel ResolutionModel Resolution

Analysis

Validation CheckValidation CheckValidation CheckValidation Check
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Importing
1. To import a model, select 3D Modeler3D Modeler3D Modeler3D Modeler > Import > Import > Import > Import ………… . 

1. An Import FileImport FileImport FileImport File dialog pops up, allowing you to browse to the desired 

file.

On the left is a list of import files that we support.  For some of these 

import options you will need an add-on translator feature in your 

license file.

On the right is the first available option for healing an imported model.  

This will be discussed in detail later.

1. Select the desired model and then OpenOpenOpenOpen.

1. The model should appear in the window with any defined healing 

applied to it.
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Characteristics of Imported Objects
The imported objects will appear with the same units and dimensions as exported 

(a 1in rod will appear as a 2.54cm rod when imported in those units).

The imported parts will arrive separately if defined separately within the import 

file.

The imported parts will retain the names assigned in the import file.

The imported file will be added to the existing model; it will not replace it.

The location of the imported file will be relative to the current coordinate system.

The material assigned to the imported parts will be Not AssignedNot AssignedNot AssignedNot Assigned.

The imported model will not have any history defined (the history tree will simply 

say ImportImportImportImport), so it requires special operations to alter the model.

If the object can not be classified as either solid, sheet or wire (e.g. it is some 

combination of the three), the object will be placed in an UnclassifiedUnclassifiedUnclassifiedUnclassified folder in the 

history tree.

Suggestions for Exporting Geometries from Drawing Tools
De-feature the model to get rid of details that are not important for EM 

simulations (e.g. small rounds, chamfers, fillets, and mechanical connectors).  

Small features will result in a large and inefficient mesh.

Use caution when exporting parts with touching (coincident) parts.  Overlapping 
objects will need adjusting in the imported model.

All parts should fit exactly when you create the assembly (materials should be in 

contact where required for electrical connections).

Thin parts may also be successfully removed and replaced later with appropriate 

2D objects (e.g. an insulating boundary in place of a thin insulating material).

Do not use the interference fit for your exported assemblies – use the slide fit so 

that parts contact exactly as desired in the EM simulation.



Ansoft Maxwell 3D Field Simulator  v11 User’s Guide 

3.1
Geometry Import/Healing

3.1-5

Adjusting Imported Geometries
Several methods can be used to adjust an imported geometry – two methods are 

described below.  Creativity can expand the following basic strategies to adjust 

most imported geometries and even allow parametric manipulation of these static 

imports.

The first method is to use a combination of the geometry primitives (cylinders, 

cubes, etc.) and Boolean expressions to add, subtract, and manipulate the 

geometries and therefore allow access to many dimensional variables.

The second method is to use surface commands on the faces of imported objects 

as described below.

Select the desired face to adjust (type ffff while in the 3D Modeler to switch to 

face select mode – type oooo to switch back to object select).

Select 3D Modeler > Surface > Move Faces > Along Normal3D Modeler > Surface > Move Faces > Along Normal3D Modeler > Surface > Move Faces > Along Normal3D Modeler > Surface > Move Faces > Along Normal and type in the 

distance the face should move along the normal.  This will contract 

(negative distance) or expand (positive distance) the object along the 

normal of the face.  This offset is now a parameterizable distance that is 

accessible in the history tree.

The following is an example of how to manipulate an imported object to 

adjust the size and position of a hole by selecting the walls of the hole.

OriginalOriginalOriginalOriginal

Along Normal Along Normal Along Normal Along Normal ---->>>>

Along Vector Along Vector Along Vector Along Vector ---->>>>

Caution!Caution!Caution!Caution!
This Move produces errors
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Common Model Errors
The following are common model errors that can be encountered during 

validation checks and when creating a mesh.

1. api_check_entity() errors.  These are errors detected by ACIS and are 

geometry and topology errors.

2. non-manifold topology.  This detects non-manifold edges and vertices that 

are present in the model (non-manifold means that a 3D object has no 

thickness at some point – i.e. two faces meet and produce a 2D sheet, 

edge, or vertex in a 3D object).

3. Body pair intersection.  This detects if pairs of bodies intersect.

4. Small feature detection.  This detects small edge length, small face area 

and sliver faces.

5. Mis-aligned entities detection.  This detects pairs of faces from bodies that 

can be aligned to remove interbody intersections.  This improves the odds 
of mesh success.

6. Mesh failure error display.  This is available for single body, body pairs and 

last simulation run (all bodies in model).  Errors reported by the meshing 

module are reported to the user.

Errors of type 1, 2, and 3 must be resolved before the mesh can be applied to the 
model.

Imported Geometry Errors
There are two types of errors related most specifically to Imported Parts:

Geometry errors

Topology errors

Geometry errors are errors in definition of the underlying geometry.

Topology errors are errors in how the underlying components like faces, edges, 

and vertices are connected.

These errors must be fixed before mesh analysis can be performed.
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Healing during Geometry Import

In the Import File dialog there is a check box “Heal Imported ObjectsHeal Imported ObjectsHeal Imported ObjectsHeal Imported Objects”

This will heal small errors that occur when converting the imported file from its 

original format to the format of the 3D Modeler (ACIS SAT v14.0).

There are two modes for healing the imported object – “auto” and “manual”.

Auto healing will try to address ACIS errors and non-manifold errors, the 
first two classes of potential errors listed earlier.

Manual healing adds small-feature removal to the auto-healing.  You can 

remove small features at this stage if you wish.  However, the usual 

approach is to apply auto-healing at this stage and leave small-feature 

removal until later.

After you import a part, you should perform a Validation CheckValidation CheckValidation CheckValidation Check as described in 

the next section.  This allows you to target problems before the model is altered 

or becomes too complex.
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Healing after Geometry Import
Healing can only be performed on objects that have no drawing history other than 

“ImportImportImportImport”.

If necessary, object history can be deleted through 3D Modeler > Purge History3D Modeler > Purge History3D Modeler > Purge History3D Modeler > Purge History.  

If this causes a warning that another object will be deleted, you may need to 

purge the history of that other object first, or purge the histories of several objects 
simultaneously.

After you import an object, you should perform a validation check Maxwell > Maxwell > Maxwell > Maxwell > 
Validation CheckValidation CheckValidation CheckValidation Check.  This lets you focus on objects and object pairs that prevent the 

mesh from being invoked.  

Fixing api_check_entity() errors
The objects that fail api_check_entity() should be analyzed via the Analyize

Objects menu item.

1. Select the objects that have ACIS errors.

2. Select 3D Modeler > Model Analysis > Analyze Objects3D Modeler > Model Analysis > Analyze Objects3D Modeler > Model Analysis > Analyze Objects3D Modeler > Model Analysis > Analyze Objects.

3. The Analysis OptionsAnalysis OptionsAnalysis OptionsAnalysis Options dialog box appears with options for small feature detection.

4. Select OKOKOKOK to proceed.
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Fixing api_check_entity() errors (Continued)
5. The Model AnalysisModel AnalysisModel AnalysisModel Analysis dialog box appears.

This dialog produces a list of problems affecting faces, edges, and vertices.

There is also the option to auto zoom to regions where problems exist.

6. Select the objects marked with “Invalid Entities Found” and click Perform > Heal Perform > Heal Perform > Heal Perform > Heal 
ObjectsObjectsObjectsObjects.  The Healing OptionsHealing OptionsHealing OptionsHealing Options dialog box appears.  Adjust parameters as 

necessary.  Click OKOKOKOK.  The Model AnalysisModel AnalysisModel AnalysisModel Analysis dialog box reappears.

7. In most cases, the objects are healed, and the errors are fixed.

8. If errors persist, select the edges and faces still containing errors and click 

DeleteDeleteDeleteDelete.  This replaces each selected face/edge object by a tolerant edge/vertex, 

respectively.  In some cases, the replacement of face/edge by edge/vertex fails.

Objects in the Model Analysis can have the following statuses:  Good, Null Body, 

Analysis not performed, Invalid entities found, Small-entity errors.

Invalid-entity errors are ACIS and non-manifold errors.  

Invalid-entity errors must be fixed before a mesh can be generated.
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Fixing non-manifold errors
The main strategy for fixing non-manifold errors is to slightly adjust the geometry 

to either add thickness to the object or delete the non-manifold edge.

Find the non-manifold face/edge/vertex either visually or with the Analyze 
Objects menu item.

Create a small box to contain the non-manifold edge.

Either unite or subtract the non-manifold object with the small box.

A unite operation will add thickness to the object at the required place.

A subtract operation will delete the non-manifold edge (and a small portion of the 

model).

This example shows a non-manifold edge along the z-axis

Use engineering judgment to decide whether this edge is in an area of high fields, 

and is therefore important.  The importance of this area can decide the size of the 

box and whether to add or subtract the box.

OriginalOriginalOriginalOriginal

Create a small box Create a small box Create a small box Create a small box 

along edgealong edgealong edgealong edge

Subtract the two objects Subtract the two objects Subtract the two objects Subtract the two objects 

to delete the edgeto delete the edgeto delete the edgeto delete the edge
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Fixing Object Pair intersection
This type of error is easily seen in a Validation Check, where the intersecting 

objects are designated with an error notification in the message window.

There are several reasons why objects could be intersecting when they are 

imported.  If care is taken with drawing and exporting the model from the desired 

CAD tool (i.e. no interference fit and no overlap in the model), then the problem is 
most likely in the translation.

You can identify which parts of the objects are intersecting by performing an 

IntersectionIntersectionIntersectionIntersection of the two objects (in the case where one object is supposed to be 

entirely inside the other you should perform a SubtractionSubtractionSubtractionSubtraction to see what part of the 
inner object is not within the outer object).

There are several ways to fix this issue.  They are as follows:

The easiest circumstance for intersecting objects is if the objects are of the same 
material with no need for any distinction between the objects.

To fix intersecting objects of the same material:

1. Select the intersecting objects.

2. Select 3D Modeler > Boolean > Unite3D Modeler > Boolean > Unite3D Modeler > Boolean > Unite3D Modeler > Boolean > Unite.

This will group all the selected objects and there will be no intersection.

In circumstances requiring separate objects the following techniques apply.
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Fixing Object Pair intersection (Continued)
In the circumstance that two adjacent objects are supposed to be coincident 

along their respective faces, yet the objects intersect, you can Align FacesAlign FacesAlign FacesAlign Faces.

Aligning faces will take two different object faces that are very close together and 

make them coincident (more on mis-aligned objects will be discussed later).

To align the faces you can use the Analyze Objects tool similar to the process in 

fixing api_check_entity() errors.

1. Make sure the histories for intersecting objects are purged.

2. Select the intersecting objects.

3. Select 3D Modeler > Model Analysis > Analyze 3D Modeler > Model Analysis > Analyze 3D Modeler > Model Analysis > Analyze 3D Modeler > Model Analysis > Analyze InterObjectInterObjectInterObjectInterObject Misalignment.Misalignment.Misalignment.Misalignment.

4. Select the individual Object Sets to find which faces are mis-aligned at a 

possibly intersecting area.

5. Select Align FacesAlign FacesAlign FacesAlign Faces to make the faces coincident.

6. Proceed with any other intersecting, mis-aligned faces.

7. Select CloseCloseCloseClose.

This set of operations should fix the intersecting errors.

Run a Validation CheckValidation CheckValidation CheckValidation Check to determine that the aligned objects do not intersect.
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Fixing Object Pair intersection (Continued)
Other circumstances for intersecting objects require manual Boolean 

manipulation.

One Boolean method of fixing intersecting objects is to subtract a copy of one 

object from the other.  In the subtract dialog, the tool object should be the object 

of which you want to keep the material definition in the overlapping area.  

For example, Box1 and Box2 intersect (picture (a) below).

Box1 is vacuum.

Box2 is copper.

Subtraction with Box1 as the Blank Part and Box2 as the Tool Part will 
define the intersecting area as the copper part (picture (b) below).

Subtraction with Box2 as the Blank Part and Box1 as the Tool Part will 

define the intersecting area as the vacuum part (picture (c) below).

Note: Note: Note: Note: Either Select Clone tool objects before subtractingClone tool objects before subtractingClone tool objects before subtractingClone tool objects before subtracting while subtracting or 
Duplicate the object (Select the tool object, then Edit > Duplicate > Around AxisEdit > Duplicate > Around AxisEdit > Duplicate > Around AxisEdit > Duplicate > Around Axis
with an Angle of 0 and a Total number of 2, or use Ctrl+CCtrl+CCtrl+CCtrl+C, Ctrl+VCtrl+VCtrl+VCtrl+V if you are in the 

original object’s coordinate system) before subtracting to retain both objects after 

the subtraction is performed.

Box1Box1Box1Box1

Box2Box2Box2Box2
(b)(b)(b)(b)

(a)(a)(a)(a)

(c)(c)(c)(c)
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Fixing Object Pair intersection (Continued)
The final method for fixing intersecting objects is a general method that is very 

robust, but more advanced.

Take for example a copper wire passing through a box that is defined as vacuum 

(pictured below).

To solve this intersection easily, you would just subtract the wire from the box as 

described in the last method.  However, this creates a situation known as 

Coincident True Surfaces, which is difficult for the 3D Modeler to mesh correctly.

One way to get around this difficulty is to create three sections to the wire (one 

section within the box and two sections on either side).  

The process is as follows:

1. Select the wire and the box.

2. Select Edit > Duplicate > Around AxisEdit > Duplicate > Around AxisEdit > Duplicate > Around AxisEdit > Duplicate > Around Axis with an Angle of 0 and a Total 

number of 2 (or Type Ctrl+CCtrl+CCtrl+CCtrl+C, then Ctrl+VCtrl+VCtrl+VCtrl+V if you are in the original object’s 
coordinate system).

3. Select the copies of both the wire and the box.

4. Select 3D Modeler > Boolean > Intersect 3D Modeler > Boolean > Intersect 3D Modeler > Boolean > Intersect 3D Modeler > Boolean > Intersect to create the middle section.

5. Select the original wire and box.

6. Select 3D Modeler > Boolean > Subtract3D Modeler > Boolean > Subtract3D Modeler > Boolean > Subtract3D Modeler > Boolean > Subtract.

Make sure the wire is in the Blank Parts and the box is in the Tool 

Parts, and the Clone tool objects before subtractingClone tool objects before subtractingClone tool objects before subtractingClone tool objects before subtracting box is checked.

7. This creates the outer sections as one part.

8. To separate the outer sections, select the outer-section wire, then Select 

3D Modeler > Boolean > Separate Bodies3D Modeler > Boolean > Separate Bodies3D Modeler > Boolean > Separate Bodies3D Modeler > Boolean > Separate Bodies.

The wire is now either completely inside the box or completely outside the box.  

There are still coincident surfaces, but these are not true surfaces.

Repeat this process for any other objects that may be intersecting.
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Meshing difficulties
When there are no ACIS errors in the model, no non-manifold objects, and no 

partial object intersections, the mesh generator can be invoked to create a valid 

mesh for the electromagnetic analysis.

Even if the geometry is valid, mesh generation can still fail.

Possible causes of mesh failure are the presence of very short edges, very small 

faces, long and thin sliver faces, and slight misalignments between faces that are 

supposed to be coincident.

Small features
Small features in the geometry can lead to a mesh that is unnecessarily large and 

contains long and thin tetrahedra that make the simulation converge slower.

Small features may even cause the mesh generation to fail.

By small, we mean details on an object that are thousands of times smaller than 
the main features of the object, and that, in most cases, are unintended 

consequences of the drawing history in another CAD tool.

Therefore, it is advantageous to remove small features.

This step is entirely optional, and although it could have been accomplished 
when an object is imported (by selecting the ManualManualManualManual radio button instead of 

AutoAutoAutoAuto), we present this information here because the previous steps were 

necessary to invoke mesh generation, while this one is optional.

To start the small-feature analysis:

1. Select the objects (their histories must be purged) and invoke Object 

Analysis through 3D Modeler > Model Analysis > Analyze Objects3D Modeler > Model Analysis > Analyze Objects3D Modeler > Model Analysis > Analyze Objects3D Modeler > Model Analysis > Analyze Objects.

2. In the Model Analysis WindowModel Analysis WindowModel Analysis WindowModel Analysis Window, select Perform > Analyze ObjectsPerform > Analyze ObjectsPerform > Analyze ObjectsPerform > Analyze Objects.

3. The software will report the smallest edge length and the smallest face 
area, and enable you to set thresholds for the detection of short edges, 

small faces, and sliver faces.

4. Click OKOKOKOK, and the analysis is performed.

This will report small features in the analyzed objects that can be Deleted 
automatically or repaired with Boolean operations in the 3D Modeler.
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Mis-aligned entities
Objects that touch each other in imported geometries don’t always have well-

aligned faces.  Often, this is a consequence of the limited level of precision in the 

imported file.

Misaligned faces can cause tiny object intersections or tiny gaps between 

objects, which in turn can lead to an inefficient mesh or even a failure to create 
the mesh.

To repair such misalignments in an automated way take the following steps:

1. Select groups of objects.

2. Select 3D Modeler > Model Analysis > Analyze 3D Modeler > Model Analysis > Analyze 3D Modeler > Model Analysis > Analyze 3D Modeler > Model Analysis > Analyze InterobjectInterobjectInterobjectInterobject MisalignmentMisalignmentMisalignmentMisalignment.

3. This will produce face pairs from different bodies that are slightly 

misaligned with respect to eachother.

4. In the window that shows this list, check the box AutoAutoAutoAuto----Zoom to SelectionZoom to SelectionZoom to SelectionZoom to Selection.

5. Select face pairs from the list to visualize which face pairs are misaligned.

6. When it appears that the faces should be aligned (either they should be 

coincident or on the same plane), click Align Faces.
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Coincident True Surfaces
True Surfaces are curved surfaces in the 3D Modeler (e.g. spheres have a true 

surface, while boxes do not).

Due to the finite nature of the mesh, these true surfaces are approximated with 

facets and tetrahedra (as explained in the section on Mesh Operations).

When two true surfaces are coincident the mesh that is constructed for each 

object must align on the coincident face.  This is difficult for the mesher.

A mesh failure can occur simply because of coincident true surfaces.

A mesh failure does not have to occur while constructing the first mesh –

coincident surface mesh errors can occur on any adaptive pass.

There are different schools of thought to avoiding mesh problems with coincident 

true surfaces.  Here are a few examples:

1) Avoid true surfaces (e.g. use a regular polyhedron in place of a cylinder –
this is usually not the preferred method).

2) Avoid coincident true surfaces (see the last example in Fixing Object Pair 

Intersection for one method to achieve this).

3) Accept the geometry you have imported (or constructed) and try to improve 
the chances of producing a usable mesh.

One method of improving the chances of a usable mesh involves increasing the 

number of facets on the true surfaces to make it easier for the mesh on each 

object to line up.  After the mesher reconciles the meshes of the two coincident 
faces, the initial mesh size can be reduced to a more manageable size by using 

the model resolution.  The procedure for this method is outlined in the following.
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Coincident True Surfaces (Continued)
1. Select the coincident surface (type ffff in the 3D Modeler to switch to face selection 

– type oooo in the 3D Modeler to switch back to object selection).

1. Select Maxwell > Mesh Operations > Assign > Surface ApproximationMaxwell > Mesh Operations > Assign > Surface ApproximationMaxwell > Mesh Operations > Assign > Surface ApproximationMaxwell > Mesh Operations > Assign > Surface Approximation…………

2. Choose Set maximum normal deviation (angle)Set maximum normal deviation (angle)Set maximum normal deviation (angle)Set maximum normal deviation (angle) and enter a small number 
(sometimes 5 deg works well, other times a smaller angle is necessary).

3. Select OKOKOKOK.

4. Proceed assigning surface approximations to other coincident faces.

2. Select objects (either as a group or sequentially) that have surface 

approximations.

1. Select Maxwell > Mesh Operations > Assign > Model ResolutionMaxwell > Mesh Operations > Assign > Model ResolutionMaxwell > Mesh Operations > Assign > Model ResolutionMaxwell > Mesh Operations > Assign > Model Resolution…………

2. Enter a number that is half the size of the smallest necessary feature.

3. Select OKOKOKOK.

4. Repeat this assignment for any other objects with too fine a mesh.
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